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1 INTRODUCING THE CSX75 SYSTEM 
1.1 Getting Started 

1.1.1 Welcome 
Welcome to the CSx75 system range. We hope that you find it a useful addition to our 
range of security products. The system design allows a fully loaded system to be housed 
in one single metal or plastic enclosure. It can be expanded as required with additional 
boards. The new menu driven keypad, the CS5500, allows you to program the system 
easily using a menu structure. If you are using a different keypad, see the relevant 
manual for programming information.   

Four different panel types are available: the CS175, the CS275, the CS575 and the 
CS875. This programming manual details how to program the CSx75 range using the 
new CS5500 LCD keypad.  

1.1.2 Default codes 
Table 1 lists the default codes for the system in each country. 

Country Country code User code Installer code Download access 
code 

Baltic states 03 1122 1278 12780000 

France 02 1122(56) 1278(00) 84800000 

Belgium 11 1122(56) 1278(00) 12780000 

Czech Republic 20 1122 1278 12780000 

Denmark 07 1122 1278 12780000 

Germany 04 1122(56) 1278(00) 12780000 

Hungary 22 1122 1278 12780000 

Ireland 12 1122 1278 12780000 

Italy 10 7777(77) 8522(22) 84800000 

Netherlands 01 1122(56) 1278(00) 12780000 

Norway 05 1122 1278 12780000 

Poland 18 1122(56) 1278(00) 84800000 

Portugal 21 1122(56) 1278(00) 84800000 

Slovak Republic 24 1122 1278 12780000 

Spain 09 1122(56) 1278(00) 84800000 

Sweden 06 1122 1278 12780000 

UK 03 1122 1278 12780000 

Table 1 Default codes 

  



 

" The brackets contain the additional digits for 6-digit codes. 

1.2 LCD keypad (CS5500) 
The CS5500 LCD keypad allows you to program the CSx75 system using a menu 
structure. 

 

 

Power (green) • On if the system is connected to the mains and the battery is OK. 

• Flashes if the system has no battery or a low battery. 

• Off if the system is not connected to the mains.  

 

Ready (green) 
 

• On when the system is ready to arm. 

• Flashes when the system is ready to force arm. 

• Off when the system cannot be armed. 

 

Fire (red) 
 

• On when a fire zone has been activated. 

• Flashes when there is a problem with a fire zone. 

• Off when all fire zones are operating correctly.  

 

Function keys • Press F1 to scroll to the start of the LCD message. 

• Press F3 to scroll to the end of the LCD message. 

In multi-area mode, these keys have specific functions. If you select one 
or more areas in this mode: 
• Press F1 to part arm the set of areas.  

• Press F2 to full arm the set of areas.  

• Press F3 to disarm the set of areas.  

You can program these keys to perform a function when not in multi-
area mode. To do this, select Installer Menu>This Keypad>Function 
Keys. For more information on navigating the menus, see page 9. 

 

No Press No to: 
• Cancel a change to the menu selection or  
• Navigate to a higher level in the menu structure or 
• Cancel a sequence when entering numeric data.  

 

 



 

 

OK Press OK to: 
• Activate the menu or 
• Accept selection changes or  
• Move forward in the menu structure or  
• Complete a sequence when entering numeric data. 

 
Hash When editing text and phone numbers: 

• Press # F1 to move to the first character or number. 

• Press # F3 to move to the last character or number. 

• Press # È to delete from the current position to the last character 
or number.  

 

Navigation keys Press the navigation keys to scroll through menu lists and options.  
When in multi-area mode or not in a menu: 
• Press Ç to display bypassed zones. 

• Press È to display problem zones.  

When editing text and phone numbers: 
• Press Ç to overwrite or insert text.  

• Press È to delete text. 

1.3  Other methods of programming 
You can use the CS5500 keypad to program the system without the menu system. This 
mode uses devices, locations and segments.  

To program in this mode using the CS5500 keypad: 

• Use the OK/Menu key instead of the * key. 

• Use the F2 key instead of the Exit key.  

To access this mode, select Installer Menu>Commands>Device/Location Programming. 
For more information on navigating the menu, see page 9. 

" The recommended programming method is to use the menu structure rather 
than devices and locations. 

 

You can also program the system using UDx75 software. For more information, see page 
16. 



 

2  PROGRAMMING THE SYSTEM 
2.1 Powering up the system 

When the CS5500 if powered up for the first time, the language, keypad defaults, partition 
and keypad must be set. These options must also be set each time a keypad is defaulted.  

• The language option sets the first language of the keypad.  

• The keypad defaults option sets the country specific keypad defaults. It does not 
default the keypad.  

• The partition and keypad options set the keypad address.  

Use the navigation keys to scroll between the different options and press OK to select an 
option. See Navigating the menus for more information. 

2.2 Entering programming mode 
Your installer code allows you to program the system through the installer menu. There 
are two levels in the installer menu. The light menu contains the most important options 
and the advanced menu contains additional options. 

1. Press OK at the system prompt and enter your installer code. For a list of default 
codes, see page 6. 

2. Use the  keys to navigate the menu. The full menu map can be found in the 
Menu Structure included in your language kit. The light menu is in green text and the 
advanced menu is in black text.  

3. Select OK to select an option or use the numerical/character keys to edit the existing 
option.  

" To switch to the advanced menu, navigate to Commands>Advanced and select 
Enabled. The keypad displays the advanced menu until this option is disabled. 

2.2.1 Changing the user interface language 
1. Press OK at the system prompt. 

2. Press OK again to display the system prompt in a different language. 

3. Press OK until you find the language you require. 

4. Continue using the keypad as normal. 

2.3 Navigating the menus 

• Press the  keys to scroll through menu lists and options.   

• Press #  to move to the same menu item for the previous option. For example, if 
you are in a submenu for zone 2, press #  to move to the same submenu for zone 
1.  

• Press #  to move to the same menu item for the next option. For example, if you 
are in a submenu for zone 2, press #  to move to the same submenu for zone 3.     

" The keypad may timeout from the menu system and return to the default display.

2.3.1 Command menu 
You can access a limited number of menu options without entering your installer code. 
This opens the command menu.  



 

4. Press OK at the system prompt. 

5. Press the  keys to enter and navigate the command menu. 

2.4 Selecting a menu option  

• Press OK to select a menu option and move forward in the menu structure.  

• Press NO to reject a menu option and move backwards in the menu structure.  

• Press F1 to move through the second line of the LCD display, one word at a time, 
from right to left.  

• Press F3 to move through the second line of the LCD display, one word at a time, 
from left to right.  

2.5 Changing a menu option 
The CSx75 has several editors that you can use to change the value of certain 
programmable menu options. You can change selection list entries, binary entries, phone 
numbers and text. This section describes how to change selection list entries, binary 
entries, numeric entries and phone numbers. For information on changing text, see page 
14. 

2.5.1 Changing selection list entries 
1. Navigate with the  keys to the relevant menu option and press OK.  

2. The current value for the menu option is displayed, for example, Enabled.  

3. Press the  keys to change the value, for example, change Enabled to Disabled.  

4. Press OK to accept the change.  

• If the new value is valid, the keypad beeps once to confirm the change and 
returns to the menu option.  

• If the new value is invalid, the keypad beeps three times to reject the change 
and returns to the menu option. 

5. Press NO to cancel the change and return to the menu option.  

2.5.2 Changing binary entries 
1. Navigate with the  keys to the relevant menu option and press OK.  

2. The current value for the menu option is displayed, for example, 1 2 3 - - - - 8 means 
that 1, 2, 3 and 8 are on (included) while 4, 5, 6 and 7 are off (excluded).  

3. Press the corresponding numerical key to change a value, for example, press 1 to 
change the state of 1 to off and press 4 to change the state of 4 to on. The display 
changes to - 2 3 4 - - - 8.  

4. Press OK to accept the changes.  

If the new values are valid, the keypad beeps once to confirm the change and 
returns to the menu option. 

If the new value is invalid, the keypad beeps three times to reject the change and 
returns to the menu option. 

5. Press NO to cancel the changes and return to the menu option. 

2.5.3 Changing numeric entries   
1. Navigate with the  keys to the relevant menu option and press OK.  

2. The current value for the menu option is displayed, for example, 55. 

3. Do one of the following: 



 

• Press a number key to clear the current value and display the value of the key 
pressed. 

• Press  to increase the current value by one. 

• Press  to decrease the current value by one. 

• Press ## to clear the current value to 0. 

4. Press the number keys to enter the value.  

5. Press OK to accept the changes. 

• If the new value is valid, the keypad beeps once to confirm the change and 
returns to the menu option. 

• If the new value is invalid, the keypad beeps three times to reject the change 
and returns to the menu option. 

6. Press NO to cancel the changes and return to the menu option. 

2.5.4 Changing phone numbers and phone prefixes 
1. Navigate with the  keys to the relevant menu option and press OK.  

2. The current value for the menu option is displayed, for example, 4567999. 

3. Do one of the following: 

• Press  to toggle between insert mode and overwrite mode (insert mode allows 
you to insert new numbers and overwrite mode allows you to overwrite existing 
numbers). 

• Press  to delete the number at the cursor position. 

• Press #  to delete all the numbers from the number at the cursor position to 
the end of the string. 

4. Do one of the following: 

• Press the keys 0 to 9 to insert new numbers. 

• Press #1 to insert a star. 

• Press #2 to insert #. 

• Press #3 to insert a four-second delay. 

• Press #4 to change to pulse dialling. 

5. Press OK to accept the changes. 

• If the new number is valid, the keypad beeps once to confirm the change and 
returns to the menu option. 

• If the new number is invalid, the keypad beeps three times to reject the change 
and returns to the menu option. 

6. Press NO to cancel the changes and return to the menu option. 

2.6 Exiting the menu system 
1. Press ## to display the OK to Exit prompt.  

2. Press OK at this prompt to exit the menu system. 

 

  



 

2.7 Programming map 
The highest level of the menu structure is outlined below. The full menu structure can be 
found in the Menu Structure included in your language kit. It provides a complete 
overview of all modules and programming entries and should be used as a reference tool 
when programming the system. For a definition of each menu structure entry, see the 
glossary at the end of this manual.   

Installer Menu  Enrol Modules   
       
   Control Panel  Inputs 
      Outputs 
      Codes 
      Communications 
      Partition Settings 
      System Settings 
      Arm Schedules 
      Home Automation 
      Model 
      Version 
      Country Code 
      Default Settings 
       
   This Keypad  Keypad Features 
      Function Keys 
      X-10 Devices 
      Copy Keypad 
      Text 
      Partition 
      Keypad Number 
      Keypad Defaults 
      Model 
      Version 
      Default Settings 
       
   Other Keypads  (1-8)  
       
   RF Receivers  RF Receiver n 
       
   CS208/CS216 Input Expanders  Input Exp n 
       
   CS507 Output Expanders  Output Exp n 
       
   CS586 Direct Connect Module  Files 
      Options 
       
   CS534 Listen-in Module  Feature Select 
      Call Back Code 
      Line Hold Digit 
      Wrong PIN Digit Entries 
      Rings to Answer 
      Timers 
      Volumes 
      X-10 Devices 
      Model 
      Version 
      Default Settings 
       
   CS320 Power Modules  Power Module n 
       
      



 

      
       
   CS535 Voice Module  Recording 
      Playback 
      Handshake Digit 
      Kiss Off Digit 
      Model 
      Version 
      Default Settings 
       
                   
   CS1700 Proximity Readers  Prox Reader n 
       
   CS7001 GSM Module  Central Station 
      Autotest 
      GSM Options 
      Model 
      Version 
      Default Settings 
       
   Commands  Alarm Memory 
     Reset Smoke Detector 
     Service Check 
     Do Self Test 
     Event Log 
     Outputs 
     Device/Location Programming 
     Advanced Menu 
 
 



 

3 EDITING TEXT 
3.1 Overview 

The CSx75 has a text editor that includes a word library. You can use this editor to 
change the text of certain programmable text options. 

1. Navigate with the  keys to the relevant menu option and press OK.  

2. Press OK to select the language you want to edit. See page 9 for more information. 

3. The current text for the menu option is displayed, for example, Zone 2. 

4. Do one of the following: 

• Press  to toggle between insert mode and overwrite mode (insert mode allows 
you to insert new text and overwrite mode allows you to overwrite existing text). 

• Press  to delete the character at the cursor position. 

• Press #  to delete all the characters from the character at the cursor position to 
the end of the string. 

5. Press the keys 0 to 9 to insert new characters. Each key cycles through lower case 
and then upper case characters. 

6. Press OK to accept the changes. The keypad beeps once to confirm the change and 
returns to the menu option. 

7. Press NO to cancel the changes and return to the menu option. 

" A flashing cursor highlights the character you are editing. 

Press F2 to toggle flashing on the current character. 

Press #F2 to toggle flashing on the current word. 

3.1.1 Example 
To change a zone name from Zone 2 to Upstairs:  

1. Navigate to Zone 2 and press OK. 

2. Press #F1 to go to the start of the zone name. 

3. Press #  to delete all the characters. 

4. Press 8 four times to enter the upper case letter ‘U’. 

5. Press 7 once to enter the lower case letter ’p’. Continue until you have entered the 
new zone name. 

6. Press OK to save your changes.  

" Each character key cycles through lower and upper case letters and language 
specific characters.  

3.2 Word library 
The word library is a predefined collection of words that speeds up text editing. As you 
type a character, the keypad automatically displays a matching word. The word library is 
enabled by default. For a complete list of words in the word library, see page 46. 

• To accept the word, press F3. The cursor moves to the end of the new word and you 
can continue to enter text.  



 

• To accept a shortened version of the word, press F3 to accept the word. Then move 
the cursor to the unnecessary characters and press  to delete them.  

• To reject the word, continue entering text as normal. 

• Press the  keys to scroll through the list of word library words.  

• To disable the word library: 

1. Navigate with the  keys to Word Library and press OK.  

2. The current state of the word library is displayed. In this case, it is enabled.  

3. Use the  keys to change the state to disabled and press OK. 

4. The keypad beeps once to accept the change and returns to Word Library.    

3.3 Installer message 
Up to four messages can be displayed on the LCD when the keypad is idle or when it 
times out from a menu. If you enable more than one message, the messages are shown 
in a continuous cycle.  

• Installer message 
You can define a message of up to two lines long that is displayed by default. You 
can enable or disable this message. 

• Date and time 
The current system date and time. You can edit, enable or disable this message. 

• Service required 
A service message that is displayed when a system fault occurs. You cannot edit 
this message but you can enable or disable it. 

• System ready/not ready 
The status of the system. You cannot edit or disable this message. 

To enable the installer message: 

1. Navigate with the  keys to This Keypad and press OK. 

2. Select Keypad Features>Display and press OK.  

3. Scroll to Custom Message and press OK. The current status of the installer 
message is displayed. In this case, it is disabled. 

4. Use the  keys to change the status to enabled and press OK.   

5. The keypad beeps once to accept the change and returns to Custom Message. 

 

 
 



 

4 PROGRAMMING WITH THE UDX75 SOFTWARE 
4.1 Other methods of programming 

You can program the system using the CS5500 keypad or the UDx75 software. This 
software allows you to download the programming information on the control panel to the 
computer running the UDx75 software, change it and upload the changes from the 
computer to the panel. It also allows you to view the program log and event log. To 
program the system using this software, you must connect the control panel to the 
computer.  

4.2 Connecting the panel to the computer 
You can connect the control panel to the computer either directly via the RS232 serial 
port or remotely via a modem.  

4.2.1 Connecting using a serial port 
Connecting via a serial port is useful if you are on site and want to connect directly to the 
alarm system.  

The connection to the CS275, CS575 or CS875 panel is made through the RS232 port 
using CS590 cable.  

The CS175 does not have an RS232 port. The connection to the CS175 is made through 
the CS586 module, which provides a standard RS232 bi-directional DB-9 connector. The 
CS586 can be used as a programming tool on any panel, as it is connected to the data 
bus. It stores control panel settings that can be up/downloaded using the keypad or a 
computer. For more information on reading data from the CS586, see the Installation 
Manual. 

To use the UDx75 software with a direct connection: 

1. Double click the icon for the software or click Start>Programs>UDX75>UDX75.  

2. The UDX75 window and the UDX75 Master access screen open. 

3. Enter the operator name and password and click OK.  

4. The UDX75 Operator access screen opens. 

5. Enter the current operator and password and click OK.  

6. To connect to the panel directly via the serial port, select Download>Connect>Direct 
connect. The Connecting message box opens. 

7. To connect to the panel via a TCP/IP network, select Download>Connect>Connect 
TCP/IP. The Reserved (TCPIP) screen opens. Enter the TCP/IP address and click 
OK. 

8. When you are finished uploading or downloading, select Download>Disconnect. 

 

" The default operator is Aritech and the default password is 
1278. You may have to enter this twice. 

4.2.2 Connecting using a modem 
You can connect the control panel to the computer remotely via a modem. This can be 
useful if you are not on site and want to connect to the alarm system.  

You can connect normally or connect using answering machine defeat (AMD). If you use 
AMD, the automatically timed two-call-answer-machine-defeat sequence is used. 



 

To use the UDx75 software with a modem connection: 

1. Follow steps 1 - 5 on page 16.  

2. Make sure that the modem settings are correct. For more information about modem 
settings, see the UDx75 Online Help.  

3. Select Download>Connect> Connect Using AMD. 

4. A message box opens saying Initializing modem. 

5. The computer connects to the panel.  

6. When you are finished uploading or downloading, select Download>Disconnect or 
click the Disconnect icon. 

4.3 Programming with up/download software 
Downloading allows you to read the existing programming data or the event log from the 
control panel. Uploading allows you to send programming data, that you have set up 
using the UDx75 software, from the computer to the control panel.  

Before you download or upload information, do the following:   

1. Ensure that the relevant control panel options are programmed correctly. There are 
a minimum number of options that you must set before you can program the control 
panel using the up/download software. Table 2 lists the options and the values to 
enter. 

2. Ensure that the up/download access code is the same in both the up/download 
software and the control panel. See Table 1 for the correct default code. 

3. If you are connecting remotely, make sure that the modem settings are correct. For 
more information about modem settings, see the UDx75 Online Help. 

4. Connect to the panel via the serial port or modem. 

5. Select Download>Read all to download all the data from the control panel. The 
computer downloads the data from the panel.  

6. Select Download>Send all to upload all the data to the control panel. The computer 
uploads the data to the panel.  

The data that is downloaded and the downloading speed depend on the Send All/Read 
All settings. The default number of strings sent to the keypad is 192 but it is possible to 
limit the number of strings sent. If the default number is reduced, download time 
decreases. For more information on setting up/download options, see the UDx75 Online 
Help. 

Keypad menu option Value 
Serial Port>Connection Type Home Automation 

Serial Port>Speed 9600 Baud 

Home Automation>Protocol Binary 

Home Automation>Transition Broadcasts Ensure all options are set to Off. This is the default state. 

Home Automation>Commands/Requests Ensure all options are set to On. This is the default state. 

Table 2 Required settings for up/downloading 



 

4.3.1 Programming tasks 
You can perform all available programming tasks using the UDx75 software. Table 3 
shows the UDx75 menu path for each task.   

Task UDx75 menu option 
Adding customer notes View>Customers>Notes 

Adding operators Program>Setup>Add/Change operators 

Backing up the database Tools>Backup database 

Changing a customer record View>Customers>Single customer 

Changing a master or operator password Program>Change password 

Changing operator rights Program>Setup>Add/Change operators 

Changing the additional phone settings View>Control panel (Additional phone settings tab) 

Changing the communicator codes Advanced>4+2 Codes 

Changing the download options Program>Setup>Download options 

Changing the partitions View>Control panel (Partition tab) 

Changing the report settings View>Control panel (Phone numbers tab) 

Changing the system 1 settings View>Control panel (System 1 tab) 

Changing the system 2 settings View>Control panel (System 2 tab) 

Changing the system 3 settings View>Control panel (System 3 tab) 

Changing the UDx75 settings Program>Setup>Program setup 

Changing the user arm/disarm codes View>Control panel (Codes tab) 

Compacting the database Tools>Compact database 

Connecting via the modem Download>Connect >Connect or Download>Connect 
>Connect using AMD 

Connecting via the serial port Download>Connect>Direct connect 

Copying a customer’s panel settings Program>Setup>Copy options 

Deleting a customer record View>Customers>Single customer 

Deleting the event log Download>Event log>Delete Event log 

Downloading Download>Send all 

Downloading and updating the device list Download>Device list>Enroll devices 

Downloading the event log Download>Event log>Read entire log 

Exporting a database Tools>Export database 



 

Task UDx75 menu option 
Importing a database Tools>Import database 

Loading the default settings Advanced>Default Control data 

Logging in Start>Programs>UDX75>UDX75 

Printing a customer record list Program>Print preview>Customer list 

Printing a program log Program>Print preview>Program log 

Printing a programming worksheet Program>Print preview>Programming worksheet 

Printing an operator list Program>Print preview>Operator list 

Printing customer notes Program>Print preview>Notes 

Printing the event log Program>Print preview>Event log  

Programming the CS1700 Expanders>CS1700>1 

Programming the CS208/CS216 View>Control panel (Zones tab) 

Programming the CS320 Expanders>CS320>1 

Programming the CS507 Expanders>CS507>1 

Programming the CS534 Expanders>CS534 

Programming the CS535 Expanders>CS535 

Programming the CS7001 Expanders>CS7001 

Programming the keypad text Expanders>Keypad text 

Programming the keypads Expanders>Keypad options>Partition 1>Keypad 1 

Programming the wireless receivers Expanders>Wireless>1 

Programming the zones View>Control panel (Zones tab) 

Repairing the database Tools>Repair database 

Restoring the database Tools>Restore database 

Retrieving and viewing a customer record View>Customers>Single customer 

Running diagnostics Tools>Diagnostics 

Setting auto call back options Program>Setup>Auto callback 

Setting customer account options View>Customers>Account options 

Setting the country and language Program>Setup>Country/Language 

Setting the download access Advanced>Download options 

Setting the format overrides Advanced>Format overrides 



 

Task UDx75 menu option 
Setting the outputs Advanced>Auxiliary outputs 

Setting the TCP/IP settings Program>Setup>TCP/IP Settings 

Setting the timed functions Advanced>Timed functions 

Setting the zone type Advanced>Zone types 

Setting up a customer record View>Customers>Single customer 

Setting up a modem Program>Setup>Modem setup 

Setting up answering machine defeat Program>Setup>AMD setup 

Specifying the direct connect settings Program>Setup>Direct connect settings 

Specifying the serial port settings Advanced>Serial port settings 

Switching operators Program>Next operator 

Uninstalling the software Start>Settings>Control Panel 

Uploading Download>Read all 

Viewing a customer record list View>Customers>List 

Viewing an operator list Program>Setup>Add/Change operators 

Viewing the auto answer failures View>Customers>Auto answer failures 

Viewing the control panel settings View>Control panel 

Viewing the event log Download>Event log>Read entire log 

Viewing the keypad status View>Keypad status 

Table 3 UDx75 menu paths 

 

  



 

5 ADVANCED PROGRAMMING 
5.1 Multi-area mode 

You can program a keypad to act as a single-area keypad or a multi-area keypad by 
default. A single-area keypad allows the user to arm one area only while a multi-area 
keypad allows the user to arm one or more areas. A user with rights can change a single-
area keypad to a multi-area keypad and vice versa.  

1. Navigate with the  keys to Multi-Area Keypad and press OK. 

• Select Enable to set the keypad as a multi-area keypad by default. 

• Select Disable to set the keypad as a single-area keypad by default. 

2. Press OK to save the setting.  

3. The keypad beeps once to confirm the change and returns to Multi-Area Keypad.  

5.2 Copying zones 
You can copy the settings for the current zone to another zone or a set of other zones. All 
the zone settings (except the user defined zone name and RF settings) are copied to the 
target zones.  

1. Navigate with the  keys to Copy Zone and press OK. 

2. The keypad prompts you to enter the start zone.  

3. Enter the number of the first zone to which the settings will be copied and press OK.  

4. The keypad prompts you to enter the end zone.  

5. Enter the number of the last zone to which the settings will be copied and press OK.  

5.3 Modifying existing zone types 
You can change the input type, name, attributes, sound and reporting features of an 
existing zone type. The following steps describe how to change the input type.  

1. Navigate with the  keys to Zone Types and press OK. 

2. Scroll to the zone type to be modified and press OK.  

3. To change the input type of the selected zone, navigate to Input Type and press OK. 

4. Use the  keys  to select an input type that you want to enable/disable for the 
selected zone type and press OK. 

5.4  Setting up a keypad to use multiple languages 
You can set several languages on the keypad.  

1. Navigate with the  keys to This Keypad and press OK. 

2. Scroll to Text>Set Languages and press OK.  

3. The current language is displayed as Language 1. 

4. Scroll to Language 2 and press OK. If no language 2 is set, a blank line is displayed.  

5. Use the  keys to select the second language and press OK. 

6. The keypad beeps once to accept the change and returns to Set Languages. 

7. Press NO to cancel the change and return to Set Languages.  



 

8. Repeat these steps to set other languages. 

5.5 Setting up a communicator  
The CSx75 supports different modes of reporting events to multiple central stations. 
There are six phone numbers - each phone number has it own account code, protocol 
and events. The configured prefix is common to all six phone numbers. If a four-second 
delay is specified in the prefix, the panel does not look for a dial tone, but performs blind-
dialling. The following scenarios are examples of how to set different modes of reporting.  

5.5.1 Reporting to one phone number  
The control panel reports events to one central station only. You specify settings for 
phone number 1. Events for phone number 1 are enabled by default. 

Level 1 Level 2 Value State 
Phone Number Phone Number 1 123456  

 Phone Number 2   

Account Code Phone Number 1 445566  

 Phone Number 2   

Protocol Phone Number 1 SIA   

 Phone Number 2   

Events Phone Number 1 – Alarms  Enabled 

 Phone Number 1 – Alarm Restores  Enabled 

 Phone Number 1 – Tampers and Restores  Enabled 

 Phone Number 2 – Alarms   

 Phone Number 2 – Alarm Restores   

 Phone Number 2 – Tampers and Restores   

 

5.5.2 Backup reporting  
Backup reporting configures the control panel to report to two or more central stations. 
The first phone number belongs to the main central station and all other phone numbers 
belong to the backup central stations. Events are reported to the first number but, if the 
panel cannot reach this number, it dials the backup number(s). The control panel makes 
two calls to each number in sequence. It performs the sequence for the number of times 
specified in ARC Dial Attempts or until it receives a kiss off. The same account code is 
used to report to all numbers. Events for phone number 1 are enabled by default and 
events for phone numbers 2 - 6 are disabled by default. If phone number 1 and phone 
number 2 are programmed, the default sequence is 1,1 2,2 1,1,2,2 for a total of eight 
calls to each number. 

Level 1 Level 2 Value State 
Phone Number Phone Number 1 123456  

 Phone Number 2 456789  



 

Level 1 Level 2 Value State 
Account Code Phone Number 1 445566  

 Phone Number 2 445566  

Protocol Phone Number 1 SIA  

 Phone Number 2 SIA  

Events Phone Number 1 – Alarms  Enabled 

 Phone Number 1 – Alarm Restores  Enabled 

 Phone Number 1 – Tampers and Restores  Enabled 

 Phone Number 2 – Alarms  Disabled 

 Phone Number 2 – Alarm Restores  Disabled 

 Phone Number 2 – Tampers and Restores  Disabled 

5.5.3 Dual reporting 
Dual reporting configures the control panel to report to two different central stations. 
Events must be reported to both phone numbers. The control panel dials the first number 
twice. If it cannot reach this number, it dials the second number twice. It performs this 
sequence for the number of times specified in ARC Dial Attempts or until it reports the 
events to both numbers. The same account code is used to report to both numbers. 
Events for phone number 1 are enabled by default and events for phone number 2 are 
disabled by default.  

Level 1 Level 2 Value State 
Phone Number Phone Number 1 123456  

 Phone Number 2 456789  

Account Code Phone Number 1 445566  

 Phone Number 2 445566  

Protocol Phone Number 1 SIA  

 Phone Number 2 SIA  

Events Phone Number 1 – Alarms  Enabled 

 Phone Number 1 – Alarm Restores  Enabled 

 Phone Number 1 – Tampers and Restores  Enabled 

 Phone Number 2 – Alarms  Enabled 

 Phone Number 2 – Alarm Restores  Enabled 

 Phone Number 2 – Tampers and Restores  Enabled 



 

5.5.4 Split reporting 
Split reporting  configures the control panel to report to two different central stations. 
Some events must be reported to phone number 1 and others to phone number 2. The 
control panel dials the first number twice. If it cannot reach this number, it dials the 
second number twice. It performs this sequence for the number of times specified in ARC 
Dial Attempts or until it reports the relevant event to each number. The same account 
code is used to report to both numbers. Events for phone number 1 are enabled by 
default and events for phone numbers 2 are disabled by default.  

Level 1 Level 2 Value State 
Phone Number Phone Number 1 123456  

 Phone Number 2 456789  

Account Code Phone Number 1 445566  

 Phone Number 2 445566  

Protocol Phone Number 1 SIA  

 Phone Number 2 SIA  

Events Phone Number 1 – Alarms  Enabled 

 Phone Number 1 – Alarm Restores  Enabled 

 Phone Number 1 – Tampers  Disabled 

 Phone Number 2 – Alarms  Disabled 

 Phone Number 2 – Alarm Restores  Disabled 

 Phone Number 2 – Tampers and Restores  Enabled 

 

 
 
 

 



 

6 PROGRAMMING A SAMPLE SYSTEM 
6.1 The sample system  

This chapter explains how to program a basic system using the tasks and settings 
outlined in Table 4. More information on installing a basic system can be found in the 
Installation Manual. Enter 1122 to silence the keypad if it starts beeping during 
programming. 

Task Programming information 
Setting up the system   

Setting the keypad partition and keypad number Partition 1 

Setting the system date and time Master user code 

Enrolling the system modules   

Defaulting the panel Module 0 

Defining the country code   

Configuring the system   

Configuring the keypads Partition 1 
Keypad 1 
Keypad 2 

Configuring zones 4 hardware zones: 
Zone 1 is an entry/exit zone. 
Zone 2 and 3 are burglary zones. 
Zone 4 is a fire zone. 

Configuring the phone settings Phone number: 0852525 
Account Code: 112233 
Protocol: SIA 

Programming the wireless modules   

Defaulting the wireless modules RF receiver module 32 

Programming the wireless detectors 2 zones: 
Zone 9 is a door/window sensor burglary zone. 
Zone 10 is a PIR detector burglary zone. 

Table 4 A sample system 

6.2 Setting up the system  
When you have installed the system, select the user interface language. For more 
information on changing the language, see page 9. 

6.2.1 Setting the keypad partition and keypad number 
You must set the partition and keypad number for the current keypad. The keypad can 
connect to the bus only after you set these numbers.   

1. The keypad prompts you to enter the partition number for the current keypad.  



 

2. Enter the partition number and press OK. In this case, enter 1. 

3. The keypad prompts you to enter the keypad number.  

4. Enter the keypad number and press OK. In this case, enter 1.  

5. The system prompt appears. 

6. Repeat the above steps for each keypad connected to the system. 

" The partition number and keypad number prompts are displayed for the initial 
setting only. To change these numbers again, scroll to This Keypad>Partition and 
This Keypad> Keypad Number. 

6.2.2 Setting the system date and time 
You must enter a master user code to set the system date and time. For a list of master 
codes, see page 6. 

1. Press OK at the system prompt. 

2. Enter the master user code.  

3. Scroll to Options>Set Date/Time and press OK. 

4. The current time is shown as day of the week, hours and minutes (ww.hh.mm). The 
current date is shown as month, day and year (mm.dd.yy).  

5. Press the  key to increase the hour or press the  key to decrease it.  

6. Press OK to accept the changes and move the cursor forward. 

7. When you have finished updating the date and time, press ## to return to the system 
prompt.  

6.2.3 Enrolling the system modules 
When you select the enrol modules process, new modules are enrolled on both the 
control panel and the keypad. The keypad must enrol modules in order to display the 
relevant menu options. 

1. Press OK at the system prompt and enter your installer code.  

2. Navigate with the  keys to Enrol Modules and press OK.  

3. The keypad starts enrolling the modules. The Enrolling Modules message is no 
longer displayed and a confirm beep sounds. 

4. When the modules have been enrolled, the message changes to Modules Enrolled. 

5. Verify the enrolled modules. Navigate with the  keys to Commands and press 
OK. 

6. Scroll to Event Log and press OK. When the control panel enrols a module, it adds 
an enrol event to the event log. This event contains the module number. Scroll 
through the event log to verify that each module has been enrolled. 

6.2.4 Defaulting the panel 
Each module can be defaulted. It is recommended that you default each module before 
modifying its settings.  

1. Navigate with the  keys to Default Settings in the relevant module menu and 
press OK. In this case, select Control Panel>Default Settings to restore the default 
control panel settings. 

2. A confirmation message is displayed. Press OK to accept the default settings. 

3. The keypad sounder beeps once to confirm the reset. 



 

6.2.5 Defining the country code 
The control panel is shipped with software that contains different country default settings. 
Changing the value or selecting a country code configures the panel with the 
corresponding country defaults.  

1. Navigate with the  keys to Country Code and press OK. The current country is 
displayed. 

2. Scroll through the countries and press OK to select the new country. For a list of 
default country codes, see Table 1 on page 6.  

6.3 Configuring the system 

6.3.1 Configuring the keypads 
You define keypad options for the current keypad. You can copy these settings to another 
keypad. The keypad number and keypad partition are NOT copied. 

1. Navigate with the  keys to This Keypad>Keypad Features and press OK.  

2. Scroll through the configurable options for the keypad. Press OK to change an 
option.  

3. Navigate with the  keys to Copy Keypad and press OK.  

4. To copy the current keypad settings to another keypad, select To One Keypad and 
select the partition number. 

5. Scroll to the keypad to which you want to copy the settings and select OK. In this 
case, select Keypad 2 and press OK to copy the settings for keypad 1 to keypad 2. 

6. To copy the settings to all other keypads, select To All Keypads. Press OK to copy 
the settings.  

6.3.2 Configuring zones 
You can program a zone to be one of 20 different zone types.  

1. Navigate with the  keys to Control Panel>Inputs>Zones and press OK.  

2. A list of all zones is displayed. Select the number of the zone that you want to 
configure and press OK.  

3. Scroll to Zone Type and press OK.  

4. Select the relevant zone type and press OK.  

• In this case, select Zone 1>Zone Type and press OK. Select entry/exit and 
press OK. 

• Press #  to move to Zone 2>Zone Type. Set the zone type to burglary. 

• Press #  to move to Zone 3>Zone Type. Set the zone type to burglary. 

• Press #  to move to Zone 4>Zone Type. Set the zone type to fire. 

6.3.3 Configuring the phone settings 
You specify the phone number, the account number and the communication protocol that 
are used to send reports to the central station.  

1. Navigate with the  keys to Control Panel>Communications>Central 
Station>Phone Numbers and press OK. 

2. Select the relevant phone number. 

3. Scroll through the configurable options for that phone. Press OK to change a setting 
for an option. For more information, see Setting up a communicator on page 22. 

•  In this case, select Phone 1 and press OK.  



 

• Scroll to Phone Number and press OK. 

• Press #  to clear the current value. 

• Enter 0852525 and press OK. 

• Scroll to Account Code and press OK.  

• Press #  to clear the current value. 

• Enter 112233 and press OK. 

• Scroll to Protocol>SIA and press OK. 

6.4 Programming the wireless modules 

6.4.1 Defaulting the wireless modules 
You must default each module before you start programming it. For more information on 
the DIP switch settings on the receiver, see the Installation Manual. 

1. Navigate with the  keys to RF Receivers and press OK.  

2. Select the relevant module bus ID and press OK. In this case select RF Receiver 32 
and press OK.  

3. Select Default Settings and press OK. 

4. A confirmation message is displayed. Press OK to accept the default settings. 

5. The keypad sounder beeps once to confirm the reset. 

6.4.2 Programming the wireless detectors 
1. Navigate with the  keys to RF Receivers and press OK. 

2. Select the relevant module bus ID and press OK. In this case select RF Receiver 32 
and press OK. 

3. Scroll to Start Zone and press OK. 

4. Enter the starting zone of the receiver. In this case, enter zone 9 to set zone 9 as the 
starting zone for receiver 32. 

5. Scroll to Learn-in Mode and press OK. 

6. To learn-in more than one device, scroll to Sequential Programming, select Yes and 
press OK.  

7. Scroll to Start Learning and press OK. 

8. Enter the zone number to start with. In this case, enter 9 to program the detectors in 
zones 9 and 10 and press OK.  

9. Tamper the different detectors in sequence.  

• In this case, tamper the door/window sensor burglary zone. A ding-dong 
confirms that the detector in zone 9 has been learned in. 

• Tamper the PIR detector. A ding-dong confirms that the detector in zone 10 has 
been learned in. 

10. Press ## to leave the programming mode. The OK to Exit prompt is displayed. The 
system now functions as a normal alarm system. See the CS5500 LCD Keypad User 
Manual for information on arming and disarming the system.  

 

 

 



 

7 READING THE EVENT LOG 
The event log displays the details of all the events that occur from when you turn the 
system on. A maximum of 512 events are held in the event log. For a list of all possible 
events, see page 46.  

To read the event log: 

1. Press OK at the system prompt and enter your installer code.  

2. Navigate with the  keys to Commands and press OK. 

3. Scroll to Event Log and press OK.            

4. The last event to be added to the log is shown. The > symbol indicates that the 
message must be scrolled horizontally. 

5. Press F3 to scroll to the right and view the rest of the event description. Table 5 
explains each part of the event description. 

Alarm 3 Press F3 Alarm 3 

168 17:32 >   25/9 028 

  

• In this case, an alarm occurred in zone 168 in partition 3 at 17:32. No report 
was sent to the central station. The event occurred on September 25. This is 
the twenty-eighth event in the log. 

6. Press the  keys to scroll through the events in the log.  

      
Event description Explanation 
L1    EventType PN PartitionName 

L2 Zone/User Name UN/ZN HH:MM DD/MM LOG 

EventType The type of event that occurred. 

PN The number of the partition in which the event occurred. 

PartitionName The name of the partition in which the event occurred. 

Zone/User Name The zone name or user name. 

UN/ZN The user number, zone number or device number. 

HH:MM The hour and the minute the event occurred. 

DD/MM The day and month the event occurred. 

LOG The position of the event in the event log. 

Table 5 Event description 

  



 

8 REFERENCE 
8.1 Appendix 1: Reporting fixed codes in Contact ID or SIA 

Table 6 lists the event codes sent for different reports (if enabled) when using Contact ID 
or SIA formats. The numbers in brackets following the event is the number that is 
reported as the zone number. If there are no parentheses, the zone is 0. An asterisk 
represents the first character from the event code of the zone that is bypassed or in 
trouble. 

Report Contact ID SIA Report Contact ID SIA 
Manual test 601 RX Keypad tamper 137 TA 

Autotest 602 RP Keypad panic(audible) 120 PA 

Open (user number) 401 OP Keypad panic (silent) 121 HA 

Close (user number) 401 CL Duress 121 HA 

Cancel (user number) 406 OC Keypad auxiliary 1 110 FA 

Download complete 412 RS Keypad auxiliary 2 100 MA 

Start program 627 LB RF sensor lost (zone 
number) 

381 *T 

End program 628 LX RF sensor restore (zone 
number) 

381 *R 

Recent close (user 
number) 

401 CR Sensor low battery (zone 
number) 

384 XT 

Exit error (user number) 457 EE Sensor battery restore (zone 
number) 

384 XR 

Event log full       605 JL Zone trouble (zone number) 380 *T 

Fail to communicate 354 RT Zone trouble restore (zone 
number) 

380 *R 

Expander trouble 
(device number) 

333 ET Zone tamper (zone number) 137 TA 

Expander restore 
(device number) 

333 ER Zone tamper restore (zone 
number) 

137 TR 

Telephone fault 351 LT Zone bypass (zone number) 570 *B 

Telephone restore 351 LR Bypass restore (zone 
number) 

570 *U 

Siren tamper (device 
number) 

321 YA Near Alarm (A/B Alarm) 138 BM 

Siren restore (device 
number) 

321 YH Early open/late close 451 OK 



 

Report Contact ID SIA Report Contact ID SIA 
Aux power over current 
(device number) 

312 YP Partial close 456 CF 

Aux power restore 
(device number) 

312 YQ Zone activity fault 391 NA 

Low battery (device 
number) 

309 YT Zone activity restore 391 NS 

Low battery restore 
(device number) 

309 YR Fail to close 454 CI 

Mains fail (device 
number) 

301 AT RF jamming 344 XQ 

Mains restore (device 
number) 

301 AR RF jamming restore 344  XH 

Box tamper (device 
number) 

137 TA Smoke detector clean me 393 YX 

Box tamper restore 
(device number) 

137 TR Smoke detector clean me 
restore 

393 YZ 

Table 6 Event codes 



 

8.2 Appendix 2: Overview of module numbers 
Every keypad, expansion module and wireless receiver module has a module number.  

Module Module number 
CSx75 0 

CS534 Two-way Listen-In 64 

CS535  77 

CS7001 78 

Table 7 Module numbers 

8.2.1 CS1700 door swipe module  
Learn-in sequence Module number   Learn-in sequence Module number 
1 113   9 121 

2 114   10 122 

3 115   11 123 

4 116   12 124 

5 117   13 125 

6 118   14 126 

7 119   15 127 

8 120   

Table 8 CS1700 module numbers 

8.2.2 Keypads 
Keypad Part1 Part2 Part3 Part4 Part5 Part6 Part7 Part8 
1 192 193 194 195 196 197 198 199 

2 200 201 202 203 204 205 206 207 

3 208 209 210 211 212 213 214 215 

4 216 217 218 219 220 221 222 223 

5 224 225 226 227 228 229 230 231 

6 232 233 234 235 236 237 238 239 

7 240 241 242 243 244 245 246 247 

8 248 249 250 251 252 253 254 255 

Table 9 Keypad module numbers 



 

8.2.3 CS208/CS216 input expander    
DIP switch setting Starting 

zone 
number 

Module 
number 

 DIP switch setting Starting 
zone 
number 

Module 
number 

      
 9    23 

        
 89   99 

      
 17   16 

        
 97   100 

      
 25   17 

        
 105 101 

      
 33   18 

        
 113 102 

      
 41   19 

        
 121 103 

      
 49   20 

        
 129 104 

     
 57   21 

       
 137 105 

     
 65   96 

       
 145 106 

     
 73   97 

       
 153 107 

     
 81   98 

       
 161 108 

 = ON      = OFF 
    

Table 10 CS208/CS216 module numbers  

8.2.4 CS208H input expander    
DIP  
switch setting 

Starting 
zone 
number 

Module 
number 

 DIP switch setting Starting 
zone 
number 

Module 
number 

     
 9    23 

       
 73   97 

     
 17   16 

       
 81   98 

     
 25   17 

       
 89   99 

     
 33   18 

       
 97   100 



 

DIP  
switch setting 

Starting 
zone 
number 

Module 
number 

 DIP switch setting Starting 
zone 
number 

Module 
number 

     
 41   19 

       
 105 101 

     
 49   20 

       
 113 102 

     
 57   21 

       
 121 103 

     
 65   96    

 = ON      = OFF 
    

Table 11 CS208H module numbers 

8.2.5 CS507 output module  
DIP switch setting Module number DIP switch setting Module number 

     
24 

     
28 

     
25 

     
29 

     
26 

     
30 

     
27 

     
31 

 = ON      = OFF 
   

Table 12 CS507 module numbers 

8.2.6 CS320 power supply module  
DIP switch setting Address  DIP switch setting Address 

   
84 

       
88 

   
85 

       
89 

     
86 

       
90 

     
87 

         
91 

 = ON      = OFF      
Table 13 CS320 module numbers 



 

DIP switches 1-3 set the address of the CS320. DIP switch 4 controls the tamper feature. 
On enables tamper. Off disables tamper. 

8.2.7 RF433 receiver module 
 

DIP switch setting RF 
receiver 

Module 
number 

 DIP switch setting RF 
receiver 

Module 
number 

       
1 34 

       
5 38 

     
2 33 

       
6 37 

     
3   32 

(default)      
7 36 

     
4 39 

      
8 35 

 = ON      = OFF     DIP switch 4 is not used 
Table 14 RF433 module numbers 

8.2.8 RF868 receiver module 
DIP switch setting RF 

receiver 
Module 
number 

 DIP switch setting RF 
receiver 

Module 
number 

       
1 34 

       
5 38 

     
2 33 

       
6 37 

     
3   32 

(default)      
7 36 

     
4 39 

      
8 35 

 = C (ON)      = O (OFF)     DIP switch 4 is not used 
Table 15 RF868 module numbers 



 

8.3 Appendix 3: Output events 
The control panel, the CS507 output expander and the CS320 power module each have 
selectable output events that trigger the output. Table 15 to Table 17 list these events.  

# Event # Event # Event 
 Misc  Keypads  Alarms 

8 Any Bypass 12 Keypad Fire 0  9 Burglary Alarm 

11 9 Duress 13 9 Keypad Medical 1  9 Fire Alarm 

48 9 Code Entry (Note 1) 14 9 Keypad Panic 2  9 24-hour Alarm 

37 Program Mode 15 Keypad Tamper 3  9 Trouble Alarm 

49 * 9 Keyfob Funct 1 47 Keypad Beeping 4  9 Tamper Alarm 

50 * 9 Keyfob Funct 2 56 Audible Panic 46 9 Any Alarm 

 Tests 57 Silent Panic 17 Alarm Memory 

29 Dyn Battery Test  Tampers and faults  Sirens 

52 Manual Test 25 Fire LED 5 Burglary Siren 

16 9 Automatic Test 39 Smoke Det Reset (Note 
2) 

6 Fire Siren 

59 Walktest Mode   40 Over-current 7 Any Siren 

 Arm/Disarm 41 Box Tamper 60 External Siren 

21 Armed  42 Siren Tamper  Communications  

22 Disarmed 43 Any Open Circuit 32 Listen-in  

23 Ready to Arm 44 Any Short Circ’t 33 Line Seizure 

24 Not Ready to Arm 45 Any Open/Short 35 Fail to Comm’ate 

53 Armed Away 26 Fire Trouble 36 Phone Line Fault 

54 Armed Stay 28 9 Expander Trouble 38 Downloading 

30 Open Period 9 Mains Failure 55 Aux Comm Fail 

31 Closed Period 10 Low Battery   

18 Entry     

19 Exit     

20 Entry or Exit     

Table 16 Control panel output events 

 

 



 

* Events 49 and 50 require RX8w8, RX16w8, RX32w8, RX8i4, RX16i4, or RX48i4 
wireless receivers to operate. 

9 If set to latched condition, these events are one second. 

 

" 1     When Event 48 is programmed, it is possible to program a user code's     
authorization to select which output(s) a particular code activates. 

 2 Always program Event 39, Fire alarm reset, to follow the event. 

 
# Event # Event # Event 
 Tampers  Misc  Communications 

25 Fire LED 8 Any Bypass 32 Listen-in 

39 Over-current 11 9 Duress 33 Line seizure 

40 Box Tamper 45 9 Code Entry 34 Failed to communicate 

41 Siren Tamper 36 Program Mode 35 Telephone line fault 

42 Any Open Zone 46 99 Keyfob Funct 1 37 Download 

26 Fire Trouble 47 99 Keyfob Funct 2  Arm/disarm 

28 9 Expander Trouble 51 CS507 Schedule 21 Armed 

9 Mains Failure 52 X-10 Alarm Mem 22 Not armed 

10 Low Battery 53 X-10 Siren 23 Ready  

 Sirens  Tests 24 Not ready  

5 Burglary Siren 29 Dyn Battery Test 30 * Open schedule  

6 Fire Siren 16 9  Automatic Test 31 * Closed schedule  

7 Any Siren  Keypads 18 Entry 

 Alarms 12 9 Manual Fire 19 Exit 

0  9 Burglary Alarm 13 9  Keypad Medical 20 Entry or exit 

1  9 Fire Alarm 14 9  Keypad panic 48 Auto arm control 

2  9 24-hour Alarm 15 Keypad tamper 49 Auto disarm control 

3  9 Trouble Alarm 44 Keypad beeping 50 Auto arm and disarm control 

4  9 Tamper Alarm 27 Chime   

43 9 Any Alarm     

17 Alarm memory     

Table 17 CS507 output expander output events 

 
 



 

 
* See Schedule Times>Opening and Schedule Times>Closing/Autoarm. 

9 If set to latched condition, these events are one second. 

99 Events 46 and 47 require RX8w8, RX16w8, RX32w8, RX8i4, RX16i4, or RX48i4 
wireless receivers to operate. 

Events 48, 49 and 50 arm or disarm the CSx75 at the open (disarm) or close 
(arm) time for the appropriate schedule. 

 

"
  

For events 48 and 50, the keypad buzzer will sound one minute prior to auto 
arm if the zone value is 1. If the zone value is 0, the keypad will not sound prior 
to auto arm. 

 

# Event # Event # Event 
 Alarms  Arm/disarm  Misc 

17 Alarm Memory 21 Armed 32 Code Entry 

 Tests 22 Disarmed 7 Program Mode 

3 Dyn Battery Test 23 Ready to Arm 0   Always On 

 Tampers 18 Entry  Keypads 

25 Fire LED 19 Exit 29 Keypad Fire 

11 Smoke Det Reset 20 Entry or Exit 30 Keypad Medical 

8 Over-current  24 Not Ready to Arm 31 Keypad Panic 

9 Box Tamper   Sirens 28 Keypad Beeping 

10 Siren Tamper 12 Burglary Siren 27 Chime 

26 Fire Trouble 13 Fire Siren  Communications 

1 Mains Failure 14 Any Siren 4 Listen-in 

2 Low Battery 15 Fire Sir Steady 5 Line Seizure 

  16 Any Sir Temporal 6 Phone Line Fault 

Table 18 CS320 power module output events  



 

8.4 Appendix 4: Communicator formats 
One of several communicator formats can be used to transmit to the receiver connected 
to phone number 1. Consult the instructions for your central station receiver to determine 
which format is compatible. Table 18 lists the selectable communication formats.  

# Format Description 
1 Contact ID 

2 SIA 

3 SIA with area modifiers 

4 Voice dialler with handshake and DTMF kiss-off 

5 Reserved 

6 4+2 with 1400/1900 double round parity 

7 4+2 with 1400/1900 Checksum parity 

8 4+2 with 2300/1800 double round parity 

9 4+2 with 2300/1800 Checksum parity 

10 Fast format 8 channel 

11 Fast format 16 channel 

12 Siren tone 

13 Reserved 

14 Reserved 

15 Format over-rides (build your own format) 

16 Reserved 

17 200 Baud FSK (France Only) 

18  200 Baud FSK Reversed (France Only) 

19 XSIA 

20 XSIA with area modifier  

21- 255 Reserved 

Table 19 Communicator formats 

" 1     If you require a format other than those listed, set the override options in 
Communications>Format Override to build the appropriate format. In addition, 
select Format Override in Communications>Central Station>Phone 
Numbers>Phone Number n>Protocol. 

 2 The voice dialer protocol does not generate an FTC (failure to communicate). 

 
 



 

8.5 Appendix 5: Service messages 
The keypad displays service messages as a result of manual and automatic tests. Table 
19 lists each message and outlines the action you should take to resolve the problem.  

Message Definition Action 
Control  
Box Tamper 

There has been interference with the 
control panel casing. 

Ensure that the casing is mounted correctly 
on a flat surface and is not damaged. If there 
is no damage, close the casing securely. 

Control  
Fail to Comm. 

The control panel tried to send a message 
to the central station but failed. 

Ensure that the phone line is connected 
properly. Use a test phone to check that the 
phone service is available. Ensure that the 
central station phone number, account and 
protocol options are correct.  

Control  
Loss of Time 

The control panel has had a total loss of 
power and the clock must be reset. 

Reset the system clock and date.  

Control  
Low Battery 

The standby battery for the control panel 
is low.   

The battery may need replacing. This may 
be a temporary condition caused by a long 
power failure.  

Control  
Over-Current 

The control panel has detected an 
excessive amount of current being drawn 
from one of the outputs and has disabled 
the output as a means of protection. 

 

Check the system for wiring faults.  

An overcurrent message can be reset only 
by triggering the siren correctly, for example, 
by generating a tamper on a zone that 
activates the sirens. This is a security 
feature to ensure that the overcurrent 
message has disappeared and the sirens 
can work properly again. 

Control  
Phone Trouble 

The phone line connected to the control 
panel is not working properly. 

Ensure that the phone line is connected 
properly. Use a test phone to check proper 
service.  

Control  
Power Trouble 

The mains power supply to the control 
panel is missing. 

Reconnect the power supply and ensure it is 
working properly. 

Control  
Siren Trouble 

The connection to the control panel’s 
siren is broken.  

Repair the open circuit. 

Expansion  
Aux. Comm. Fail 

A reporting module tried to send a 
message to the central station but failed. 

Ensure that the phone line is connected 
properly. Use a test phone to check that the 
phone service is available. Ensure that the 
central station phone number, account and 
protocol options are correct. Check that the 
module is connected and working.  

Expansion  
Box Tamper 

There has been interference with the 
casing of an expansion module. 

Ensure that the casing is not damaged and 
is mounted correctly on a flat surface. If 
there is no damage, close the casing 
securely. 

Expansion  
Low Battery 

The standby battery in an expansion 
module is low. 

The battery may need replacing. This may 
be a temporary condition caused by a long 
power failure. 



 

Message Definition Action 
Expansion 
Over-Current 

The expansion module has detected an 
excessive amount of current being drawn 
from one of its outputs and has disabled 
the output as a means of protection. 

Check the module for wiring faults.  

Expansion 
Power Trouble 

The mains power supply is not connected 
to an expansion module power supply. 

Reconnect the mains power supply and 
ensure it is working properly. 

Expansion  
Siren Trouble 

The connection to an expansion module’s 
siren is broken.   

Repair the open circuit. 

Expansion 
Trouble 

An expansion module or keypad is not 
reporting to the control panel. 

Ensure that the module is connected 
properly to the control panel. 

Zone Problem, 
Press OK 

There is a problem with a zone or zones. 
Press OK to identify the zone(s) and the 
problem condition. 

One of the following messages is 
displayed when you press OK.  

  

 CleanMe A specific smoke detector 
(for example, DP721) is 
dirty. The panel detects a 
degree of pollution in the 
chamber of the fire/smoke 
detectors.  

Clean the detection chamber of the smoke 
detector. 

 Lost  The system has not 
received RF sensor 
transmissions for a long 
period of time. Depending 
on how the system is 
programmed, this 
condition activates a 
service report. In addition, 
it may activate a tamper 
alarm if armed. 

Ensure that the wireless zone module is 
receiving power and has not been tampered 
with. Repair any faults.  

 Low Battery  An RF sensor battery is 
low. 

Replace the battery. 

 Short Loss  The system has not 
received RF sensor 
transmissions for a short 
period of time. This 
condition prevents arming.

Ensure that the wireless zone module is 
receiving power and has not been tampered 
with. Repair any faults. 

 Tamper  There is a problem with 
the wiring. 

Check the zone and zone sensors for 
damage and repair any faults. 

 Trouble  There is a problem with 
the wiring. 

Check the zone and zone sensors for 
damage and repair any faults. 

Table 20 Service messages 



 

8.6 Appendix 6: Tasks summary 

Task Installer Master user User No code Condition* 
Adjusting the LCD contrast  9    

Answer an up/download call  9 9 9  

Arm and disarm the system 9* 9 9*  If authority allows. 

Bypass a zone  9* 9* 9* If authority allows. 

Configure home automation 
devices 

9 9    

Control home automation 
devices 

9 9 9 9  

Engineer tamper reset 9 9*   If enabled for 
master users. 

Initiate an up/download call  9 9 9* If enabled for use 
without a code. 

Perform a configured test 9 9 9   

Perform a service check 9 9 9 9  

Perform a walktest  9    

Program voice phone numbers 9 9    

Reset fire detector 9 9 9 9  

Set system date and time  9    

Set user authority level  9    

Set user codes 9 9 9*  Only own code 
All codes for 
master user. 

Switch to multi-area mode  9 9   

View the alarm memory 9 9 9 9  

View the event log 9 9    

Table 21 System tasks 



 

8.7 Appendix 7: Event log events 

Event message Explanation 
Alarm An alarm has been tripped. 

Alarm Restore See Alarm event message. 

Autotest An autotest message was sent to the central station. 

B-Alarm  A full alarm on a B zone type that is considered a burglary alarm.  

Box Tamper A box tamper. 

Box Tamper 
Restore 

See Box Tamper event message. 

Burglary A burglary zone has been tripped.  

Burglary Restore See Burglary event message. 

Bypass A zone is bypassed. 

Bypass Restore See Bypass event message. 

Cancel The report to the central station has been cancelled. This occurs when a user enters 
a code after an alarm. 

CleanMe A smoke detector is dirty.  

CleanMe Restore See CleanMe event message. 

Clock Set A user set the date and time. 

Close (arm) Closing (arm) by a specific user. 

Code Entry The lock of the access reader has been triggered.  

The lock can be triggered by an accepted proximity card or by an Egress switch. An 
Egress switch is a button that can be pressed by a user to open the lock of the door. 
It can also be called Request-to-Exit (RTE). When the Code Entry option is 
activated, the reader sends a log message to the control panel, indicating that the 
lock has been triggered. 

Data Lost The panel has been unable to send alarm messages to the central station. The 
panel tries to send these messages a number of times as specified in the FTC (Dial 
attempts before Fail to Communicate). Any pending reportable events are lost. 

Disarm from Alarm A user disarmed the panel during an alarm. 

Duress A duress code entered by a user. An alarm message is sent to the central station. 

Early Open A user disarmed the system before the open time specified in the panel schedules. 

End Download The end of an up/download. 

End Prog End programming. The installer left programming mode. 

End Walktest See Walktest event message. 



 

Event message Explanation 
Enrolled Modules are enrolled on the bus. The module numbers are recorded.  

Exit Error An exit door remained open after the exit delay expired. 

Expander Trouble A problem with an expander module. 

Expander Trouble 
Restore 

See Expander Trouble event message. 

Expansion Event A bus device generated an event to report conditions not described by other events. 

Fail to 
Communicate 

The control panel or module tried to send a message to a central station but failed. 

Fire A fire alarm has been tripped. 

Fire Restore See Fire event message. 

First Open The time at which the first area was opened.  

Keypad Tamper A keypad tamper.   

Last Close The time at which the last area was closed. 

Late Close A user disarmed the system after the closing time specified in the panel schedules. 

Listen-in The start of a listen-in session.  

Log Full The event log is full and the events must be reported to the up/download software. 
An event can also be sent to the central station. 

Low Batt Restore See Low Battery event message. 

Low Battery The standby battery for the control panel/expansion module is low. 

Mains Fail Restore See Mains Failure event message. 

Mains Failure The 220 V has disappeared. 

Manual Fire A manual fire alarm generated by pressing the keys 1 and 3 on the keypad. 

Manual Test A manual test call to the central station. 

Medical (Aux2) A medical alarm generated by pressing the keys 4 and 6 on the keypad. 

Open (disarm) Opening (disarm) by a specific user. 

Output An output has been activated or restored. The output number is logged. This is 
linked to the output module number.  

Output Restore See Output event message. 

Output Trip An output has been activated. 

Over-current An excessive amount of current has been drawn from one of the outputs. 

Over-current 
Restore 

See Over-current event message. 



 

Event message Explanation 
PA Panic Alarm A personal attack alarm has been tripped. 

Panic Keypad A panic alarm generated by pressing the keys 7 and 9 on the keypad. 

Partarm See Partial Arm event message. 

Partial Arm Part arm of the system by a specific user. 

Recent Closing An alarm occurred within five minutes of the panel being armed.  

Re-exit A special feature of false alarm preventing.  

Reset A user has manually reset a smoke detector.  

RF Jam Restore See RF Jammed event message. 

RF Jammed RF jamming.  

RF Low Battery An RF transmitter has reported a low battery. 

RF Low Battery 
Restore 

See RF Low Battery event message. 

Service End End of the ‘Installer on-site’ (service mode). 

Service Start Start of the ‘Installer on-site’ (service mode).  

Silent Panic A silent panic alarm. 

Siren Tamper A siren tamper. 

Siren Tamper 
Restore 

See Siren Tamper event message. 

Start Download The start of an up/download. 

Start Prog Start programming. The installer entered programming mode. 

Tamper A tamper.  

Tamper Restore See Tamper event message.  

Telephone Fault Telephone line faults. 

Telephone Fault 
Restore 

See Telephone Fault event message. 

Trouble A trouble condition.  

Trouble Restore See Trouble event message. 

Walktest The start/end of a walktest. 

Zone Inactive 
Restore 

See Zone Inactivity event message. 

Zone Inactivity A zone inactivity monitoring event. 



 

Event message Explanation 
Zone Lost An RF transmitter has lost the supervision with the wireless receiver. This happens 

when the transmitter has not reported its supervision message to the RF receiver 
within the long supervision window. See appendix 5. 

Zone Lost Restore See Zone Lost event message. 

Table 22 Event list 

8.8 Appendix 8: Word library words 
Alarm Delay Exterior House Microwave Room Smoke Up 

Area Den Fire Infrared Motion Rumpus Sound Utility 

Audio Detector Front Instant North Safe South Vault 

Back Dining Game Interior Nursery Sensor Stairs Warehouse

Bathroom Door Garage Junk Office Shock Storage West 

Beam Down Glassbreak Kitchen Panic Shop Study Window 

Bedroom Duress Guest Library Pantry Side Tamper Wing 

Button East Hall Light Phone Skylight Television Wireless 

Ceiling Emergency Heat Living PIR Sliding Trouble Yard 

Closet Exit Holdup Master Porch Small TV Zone 

Table 23 Word library 

 
 

 
 
 

  



 

9 GLOSSARY 
Term Definition  
1st Keypad Function A menu entry that groups keypad options that enable home automation 

commands. The commands activate the primary function of a keypad. These 
options are With PIN and Without PIN.  

 

200Bd FSK Channel A menu option that sets the channel used by the selected zone, zone type or 
event for 200Bd FSK protocol. The zones between 1 and 99 can be directed to 
separate channels. The zones between 100 and 168 follow the 200Bd FSK 
Channel as specified on the zone type.  

 

24-hour 
  

A zone where reaction is not dependent on the arm/disarm state of the system. It 
is permanently active 24 hours a day unless bypassed by forced arming. An 
example of a 24-hour zone is a fire, panic or glassbreak zone. 

 

24-hour Clock A menu option that switches between 24-hour and 12-hour notation.   
2nd Keypad Function A menu option that enables the home automation command that activates the 

secondary function of a keypad. 
 

2-wire Smoke Detectors A menu option that enables the 2-wire smoke detector in the control panel. A       
2-wire smoke detector is connected to the control panel with two wires instead of 
four. A maximum number of three 2-wire smoke detectors can be connected.  

 

4/6 Digit Codes A menu option that specifies whether a four or six digit code is used.  
4+2 Code  A menu option that specifies the event code sent to the central station indicating a 

4+2 alarm. The code is six digits long – four digits for the account code and two 
digits for the zone ID. The zone ID refers to the zone that is in alarm. 

 

4+2 Restore Code  A menu option that specifies the event code sent to the central station indicating a 
4+2 restore. The code is six digits long – four digits for the account code and two 
digits for the zone ID. The zone ID refers to the zone that is in alarm. 

 

45 Minute Retry A menu option that causes the panel to try to arm after every 45 minutes of 
inactivity until the next Opening time, or until the system is armed. The 45-minute 
timer is extended when there is activity in the building. This causes the Ready 
LED to turn off and on. If closing reports are sent, the user code is 97. 
See also Partitions Autoarming  

 

5 sec silence A menu option that silences the pulsing keypad sounder for five seconds when a 
key is pressed.  

 

A    
Abort To cancel an action, for example, to cancel an alarm report.   
Accept beep A control panel sound confirming the acceptance of a code, command or value 

update.  
 

Access Code A menu option that specifies the eight-digit access code sent by the up/download 
software to the control panel. The panel permits downloading to occur when it 
receives this code.  
See also User Code 

 

Access reader  See CS1700 Proximity Readers   
Account Code 
  

A menu option that specifies the unique code sent from the modem in the control 
panel to the central station. The central station uses this code to identify and 
charge the user. Separate account codes can be set up for each phone number 
and each partition. This is also known as the account number. 

 

Activate Relay  A menu option that activates the CS1700 proximity reader’s built in relay driver 
instead of an external relay driver.  

 

Active A menu option that specifies the days of the week that a particular schedule is 
active. If this option is set to Holidays, the schedule is active on the dates 
specified in Date of holidays. 

 

Address Message A menu command that records the address message. This message is sent by the 
CS535 voice module and states where an event has occurred. (Recording) 
A menu command that plays back the address message. (Playback) 

 



 

Term Definition  
Advanced Menu A menu option that activates certain options in the Installer menu structure. The 

following menus are enabled only if the Advanced Installer menu is enabled. 
(Installer) 
(i) Zone Types 
(ii) Communicator>Format Override 
(iii) This keypad>Zone Type Names 
(iv) Device/Location Programming 
(v) CS7001 GSM Module>Phone Line Cut 
(vi) CS7001 GSM Module 

 

Alarm Memory A list of alarms and where they occurred. Only the alarms that have occurred 
during the last arm/disarm cycle are shown in the alarm memory log. 

 

Alarm Restores A menu option that sends a report to the selected phone number when the alarm 
has been restored after an alarm. (Phone Numbers)  
A menu option that sends a report to the central station when an alarm has been 
restored, depending on the condition of the panel dialler. (CS7001 GSM Module) 
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

Alarm status The current state of the system. This can be armed, part armed, full armed or 
disarmed.  

 

Alarms  A menu option that sends a report to the central station when an alarm occurs. 
(Arm/Disarm/Alarm)  
A menu entry that groups together the alarm events that can be selected to trigger 
an output. (Event) 
A menu option that sends a report to the central station when an alarm occurs, 
depending on the condition of the panel dialler. (CS7001 GSM Module) 
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

All Abort A menu option that aborts all on-board communications. Any alarms in the dialler 
buffer waiting to be sent to the central station are cancelled.  

 

All in Sequence A menu command that records all CS535 voice module messages in sequence. 
The sequence is: Leader message; 15 messages that can be linked to different 
types of event (such as, alarms or opening/closing); Kiss off message; Address 
message.  (Recording) 
A menu command that plays back all CS535 voice module messages in 
sequence. (Playback) 

 

Alpha-numeric keys Keypad keys that are used to enter numbers, text and symbols to the control 
panel. 

 

Answer Machine Defeat A call-in option used to defeat an answering machine. There are two types of 
Answer Machine Defeat (AMD): 

1. CS534 listen-in module: A telephone call is made to the premises and is 
answered by an answering machine or other device. If tone-sniff AMD is 
enabled, only one call is required to defeat the answering machine. The 
computer calls the panel as normal. When the answering machine 
answers, the panel hears the tones from the modem and seizes the phone 
line for a download.  

2. Control panel: If two-call AMD is enabled, two telephone calls are required 
to defeat the answering machine. On the first call, the phone rings once or 
twice. The control panel detects the rings and starts a 45-second timer. 
During this timer, the control panel answers the next call on the first ring. 
This is not recommended for commercial applications. 

 

Antenna Tamper A menu option that sends a report if the antenna on the selected RF receiver is 
removed or damaged (cut).  

 

Anti-Lock-Up tone A tone that sounds at the central station every few seconds during a two-way 
session. During this tone the control panel disables the microphones so that it can 
detect a key press from the central station. This is useful in a noisy environment to 
prevent a loss of central station control. 

 

Anti-Lock-Up Tone Time A menu option that sets the interval at which the anti-lock-up tone is sounded at 
the central station.  

 



 

Term Definition  
ARC (alarm report 
centre) 

The place to which the control panel reports alarms and other events (such as, 
system faults, opening/closing and diagnostic events). The ARC is also known as 
a control station or a central station. 

 

ARC Dial Attempts A menu option that specifies the number of dial attempts (1 to 15 attempts) that 
the communicator makes when reporting to the central station.  

 

Area See Partition  
Arm Away A menu option that enables the arm away function for the selected proximity 

reader action. The actions are Single Badge, Double Badge and Badge Hold. 
 

Arm Away mode An arm mode in which the entire system is turned on and no one is on the 
premises. 

 

Arm Only A menu option that specifies a code that arms the system and does not perform 
any other function. For example, the code issued to service staff.   

 

Arm Only After Closing A menu option that specifies a code that arms the system during the close window 
only (when the system is scheduled to be armed). If entered during the open 
window when the system is turned off, the code does not arm the system.  

 

Arm Schedules A menu entry that groups scheduling options. These options configure the 
schedules used by the control panel for auto arming.  

 

Arm Stay A menu option that enables the arm stay function for the selected proximity reader 
action. The actions are Single Badge, Double Badge and Badge Hold. 

 

Arm Stay mode An arm mode that enables perimeter protection. Interior zones are bypassed and 
perimeter zones are armed. Bypassed zones are automatically unbypassed when 
the system is disarmed from the Arm Stay mode. 

 

Arm/Disarm A menu entry that groups the events that can be used to trigger outputs. The 
entry is available to make selection of output events more convenient. (Event) 
A menu option that specifies a four-digit or six-digit code that arms or disarms the 
system depending on its current status. (Codes >Authority) 

 

Arm/Disarm/Alarm A menu entry that groups the events that are sent to the central station. The entry 
is available to make selection of events more convenient.  

 

Armed State A menu option that lights LED 2 (Red) when the system is armed.   
Armed Zone Info An menu option that enables the mode that displays zone status on the keypad 

when the system is armed. When this mode is disabled, zone status information is 
not displayed when armed. 

 

Arming A menu option that causes the internal sounder to blast when the system arms. 
(Short Blast On) 
A menu entry that groups the arming characteristics of the selected partition. 
(Feature Select)  

 

Arming with Zone Lost A menu option that allows the system to be armed when RF zones have not 
reported to the RF receiver for a period longer than the normal supervision 
window. When this option is disabled, the system cannot be armed when an RF 
zone is lost.  
See also Supervision 

 

Arming/Disarming A menu option that allows the end-user to arm/disarm the system from a remote 
location using a touch phone (for example, GSM). This option enables level 8.  
See also Volumes  

 

At Disarm A menu option that sends a restore report to the central station when a code is 
entered to disarm the system.  
See also Send Restores 

 

Attributes A menu entry that groups the programmable attributes of the selected output. 
(Outputs) 
A menu entry that groups the additional characteristics of the selected zone type. 
(Zone) 
See also Input Type  

 

Audible PA (7+9) A system option that causes the keypad to beep and sounds the internal and 
external sirens when a PA alarm is activated.  

 

Authority  A menu entry that groups access options. These options specify the level of 
access an individual has when using the control panel.  

 



 

Term Definition  
Auto Bypass A menu option that automatically bypasses interior follower zones if no exit is 

detected during the exit delay time. The exit is detected by the opening and 
closing of an entry/exit zone. 

 

Autotest  A menu entry that groups options that configure the automatic test run by the 
system. (Communications) 
A menu option that enables reporting of autotest events to the central station at a 
specified interval. (System Reports) 
A menu entry that groups the report codes sent to the central station when an 
autotest is performed. (Report Codes) 

 

Autotest Control A menu option that specifies whether the autotest occurs after a specified number 
of days or hours. The autotest can be suppressed if another report has been sent.

 

Autotest Delay A menu option that specifies the number of hours that must elapse before the first 
test call is sent.  

 

Autotest Disarmed No 
Call 

A system option that allows test calls to be made only when the system is armed.  

Aux Overcurrent  A menu option that enables overcurrent reporting. A report is sent to the selected 
central station when too much current is drawn from a device powered by the 
system. (System Reports) 
A menu entry that groups the report codes sent to the central station when an 
overcurrent event occurs. (Report Codes) 
See also Aux Overcurrent and Restores 

 

Aux Overcurrent and 
Restores  

A menu option that sends a report to the selected phone number when too much 
current is detected. A restore report is also sent when the overcurrent condition is 
fixed. (Phone Numbers) 
A menu option that sends aux overcurrent and restore reports to the central 
station, depending on the condition of the panel dialler. (CS7001 GSM Module) 
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

Away mode See Arm Away mode  
B    
Badge Double/Hold Time A menu option that specifies the length of time during which the proximity card 

must be held near the proximity reader to activate its functions. A proximity reader 
can be programmed to activate different functions depending on whether the card 
is held near it once, twice within this time or continuously for this time.  

 

Badge Functions A menu entry that groups the functions activated by Single Badge, Double Badge 
and Badge Hold actions.  

 

Badge Hold A menu entry that groups the functions activated by holding a proximity card near 
the proximity reader for longer than the time set in Badge Double/Hold Time. 
(Badge Functions)  
A menu option that sets the X-10 function sent when a proximity card is held near 
the proximity reader for longer than the time set in Badge Double/Hold Time (X-10 
Functions) 

 

B-Alarm Timer A menu option that sets the time during which a second B-Alarm Trip event is 
treated as a full burglary alarm.  

 

B-Alarm Trip A zone type that generates a B-alarm trip event. The event is reported to the 
central station using the codes set in the B-Alarm Trip report codes menu.  
Typically, all alarms are A-alarms. Both A-alarms and B-alarms activate sirens and 
keypad buzzers. However, the central station reacts differently to A and B-alarm 
trip events. A police patrol is sent when an A-alarm trip event is reported (full 
alarm), whereas a guard from the security company is sent when a B-alarm trip 
event is reported (near alarm).  
If two B-alarm trip events occur within the pre-set B-alarm time, the second B-
alarm trip event is treated as an A-alarm trip event. (Zone Types) 
A menu option that sounds the keypad buzzer when a B-Alarm Trip event occurs. 
(Sound On) 
A menu entry that groups the report codes sent to the central station when a B-
Alarm Trip event occurs. (Report Codes) 

 



 

Term Definition  
Batt Dynamic Test 
Duration 

A menu option that sets the length of time that the control panel performs the 
Dynamic Battery test.  This can be between 0 to 255 minutes where 0 is no test.  

 

Batt Presence Test A menu option that enables a test to determine whether the battery is connected 
to the system. This test is usually performed automatically when the system is first 
powered up and periodically thereafter.  

 

Battery Test See Batt Presence Test   
Battery Test Time See Batt Dynamic Test Duration  
Baud rate A data communications speed used on a serial port. For example, 2400 Baud, 

4800 Baud, 9600 Baud, 19200 Baud, 38400 Baud.  
 

Beep on Panics A menu option that sounds a keypad beep when the personal attack alarm 
combination keys are held down long enough. 

 

Beep on RF Lost A menu option that activates the keypad sounder, causing it to beep, when an RF 
zone is lost. This beep indicates that the receiver did not receive the supervision 
signal from the wireless transmitter.  

 

Bit Error Rate A menu option that specifies the Bit Error Rate reading in GSM module modem 
applications. The BER is set at nine if unknown. This information is used for 
verification purposes only.  

 

Blank Keypads 
  

A menu option that allows an authorised user to turn off all LEDs (except the 
Power LED) on the keypad and to lock the keypad so that it does not accept key 
presses. 

 

Blind dialling A mode in which the control panel does not wait for a dial tone before dialling the 
phone number. Blind dialling is enabled by programming a four second delay (#3) 
as the first digit in Phone Prefix. It is used when the phone system has a poor 
quality dial tone or does not generate a dial tone. 
See also Phone Prefix 

 

Box Tamper A menu option that sends a report if the box tamper is detected. (System Reports)
A menu option that enables the box tamper switch on the control panel. The 
CSx75 has an input for a normally closed tamper switch. When opened, a box 
tamper is reported as an event. (System Settings) 
A menu option that enables the box tamper switch on the selected RF receiver. 
(RF Receivers) 
See also Case Tamper 

 

Box Trouble A menu entry that groups the report codes sent to the central station when a Box 
Trouble condition is activated. (Report Codes) 
See also Case Tamper 

 

Broadcast X10 Function A menu option that causes the CS1700 proximity reader to transmit an X-10 
function to the home automation system. 

 

Burglary alarm An alarm that occurs when the system is armed and a burglary zone is activated. 
An event can be programmed to report to the central station.  

 

Burglary zone  A zone type that generates an alarm if it is activated when armed. A forced arm 
can exclude a burglary zone. 

 

Bus A method of connecting devices together. Every device is connected to the same 
set of wires and has a unique address. 

 

Bus Comm Error A menu option that sets the SIA character, the partition and user number that are 
sent by the GSM module when Bus communication problems occur.  

 

Buzzer A local low volume vibrating audio output, typically located in the keypad.  
Buzzer Follows Keypad A menu option that makes the reader buzzer settings the same as the keypad 

buzzer settings. This is a CS1700 proximity reader option. 
 

Bypass To temporarily remove a zone from operation when arming the system.   
Bypass on Force Arm A menu option that enables bypass reporting when a zone is force armed.   
Bypass Toggle A menu option that allows an interior zone be bypassed or included while the 

system is armed. 
 

Bypass Zones A menu option that allows the selected code to bypass zones.   
Bypassable A zone characteristic that allows the zone to be bypassed.   



 

Term Definition  
Bypassed zones Zones that are excluded when the rest of the system is armed. They can be 

entered without triggering an alarm. 
 

C    
Call Back Code A menu option that specifies the code that starts a listen-in session when the 

panel is in call back mode. This code can be a maximum of six digits long.  
 

Call Back mode 
  

A programmable mode that allows the central station to call the premises and 
begin a two-way session.  

 

Call Back Number A menu option that specifies the telephone number that the control panel dials if 
the Call Back Req’d option is enabled. 

 

Call Back Req’d A menu option that controls access of the up/download software to the control 
panel. When the software calls the control panel, the panel answers the call and 
then hangs up. After approximately 36 seconds, the panel calls the software back.

 

Call Back Window Timer A menu option that sets the amount of time, in one-minute increments, that the 
CS534 listen-in module will wait to call back after an alarm has been reported. 

 

Call PC on Autotest A menu option that allows the panel to use call back when the central station 
performs an autotest. After the test report is delivered to the central station, the 
panel calls the up/download software using the call back phone number. Actions, 
such as upload event log and download phone numbers, can be selected in the 
up/download software.  

 

Cancel  
  

A menu option that enables cancel reporting. A cancel report is sent to the central 
station when the system is disarmed (within the time specified by the dialler delay) 
after an alarm. (Reporting) 
A menu entry that groups the report codes sent to the central station when a 
Cancel event occurs. (Report Codes) 

 

Cannot log into GSM 
Network 

A menu option that indicates the status of the GSM module when it cannot log into 
the GSM network. 

 

Card Serial Numbers A menu option that specifies the serial numbers of the cards that are recognized 
by the card reader. It is not recommended to change these serial numbers.  

 

Case Tamper  A menu option that sends a tamper report to the central station and activates a 
siren and/or the keypad when interference with keypad housing occurs.  
A tamper occurs when the casing of a piece of hardware (for example, the control 
panel, sound box or keypad) is interfered with. The CSx75 has an input for a 
normally closed tamper switch. When opened, a box/case tamper is reported as 
an event. 

 

Central station A menu entry that groups options relating to the central station. This is a remote 
location that is designed to monitor signals and reports from alarm systems and 
summon assistance if necessary. This is also known as a control station or ARC. 

 

Chime 
  

A menu option that activates an audible output for two seconds when a burglar 
zone opens. A chime is generally a single stroke signal and is often used as an 
indication on a shop door. This can be set as a zone type. 

 

Chime Time A menu option that sets the length of time that the chime operates. This time can 
be set in 50 ms (1/20th second) increments from 0-12 seconds. 0 = follows zone. 

 

Clock A menu option that displays the clock on the keypad. This is the internal real time 
clock used for the schedules and autotest intervals. (This Keypad) 
A menu entry that groups options that configure the clock. (System Settings) 

 

Closing A menu option that sets the time at which the selected schedule enters the closed 
state. (Schedules) 
A menu entry that groups the report codes sent to the central station when the 
system arms. (Report Codes) 

 

Closing Kissoff A menu option that causes the internal sounder to blast when the central station 
receives a closing report. 

 

Closing/Autoarm A menu option that sets the time after which the partitions selected in Partitions 
Autoarming start to arm automatically. Users with arm only after closing rights can 
arm the partitions selected in Partitions Opening only after this time.  

 

Code A menu option that sets the user code. This is a series of four or six numbers that 
allows access to the system. 

 



 

Term Definition  
Code Required A menu option that specifies whether a user code is required for bypassing zones.  
Code Stops Timer A menu option that allows the timer used on programmable outputs to be reset by 

entering a valid user code.  
 

Codes A menu entry that groups user code options.   
Combination keys Programmable keys that activate the fire alarm, medical alert and personal attack 

alarm. Typically, these are 1+3 (fire alarm), 4+6 (medical alert) and 7+9 (personal 
attack alarm). Check the keypad sticker for the correct combination. 

 

Commands A menu entry that groups options relating to issuing commands by the installer.   
Commands/Requests 
  

A menu option that performs commands sent to the serial port module by the 
home automation system. These include arming and disarming, programming and 
bypassing zones.  

 

Comms Settings A menu option that prevents the installer changing the communication settings 
(telephone numbers, account codes and so on). This option must be set using the 
up/download software. 

 

Communications A menu entry that groups options for communication between the control panel 
and the up/download software or central stations.  

 

Communicator A modem that can communicate alarms or other information to another location 
over telephone lines.  

 

Configuration The arrangement of the hardware and software of the system set up for a 
particular installation. 

 

Connection Fault A menu entry that groups connection fault options. A connection fault occurs 
when the GSM module cannot log into the GSM network. 

 

Connection Type A menu option on the serial port that specifies what the serial port is used for. It 
can be set to Serial printer or Home Automation Protocol.  

 

Contact ID Code A menu option that specifies the contact ID code to be used when reporting the 
selected zone type. The Contact ID codes are listed in the CS5500 Programming 
Manual.  

 

Control Panel A menu entry that groups all options relating to the central processing unit of the 
alarm system. The control panel monitors the detection devices and activates any 
number of signalling devices. 

 

Control unit See Control Panel  
Controller The main system electronics housed in a metal enclosure.  
Copy Keypad A menu option that copies the current keypad settings to another or multiple 

keypads in the system.  
 

Copy Language A menu option that copies information from the current keypad descriptors to 
another or multiple keypads in the system. Included are the zone descriptors, 
custom message, shutdown message, zone names and partition names.  

 

Copy Zone  A menu option that copies the settings for an individual zone to a contiguous set of 
other zones. All the zone settings (except the user defined zone name and RF 
settings) are copied to the target zones.  

 

Copy Zone Type A menu option that copies the settings for a zone type to a new zone type.   
Country Code A menu option that specifies the country code. This code sets the specific country 

defaults on the control panel.  
 

CS1700 Proximity 
Readers 

A proximity card reader/door control module that can be programmed to control 
access in any or all areas. 

 

CS208/CS216 Input 
Expanders 

An expander board that increases the number of wired inputs that can be used for 
a particular zone. It has an optional tamper switch and a power isolator for use in a 
remote location. It cannot be used on the CS175 or CS275 control panel. The 
CS208 has 8 zones and the CS216 has 16 zones. 

 

CS320 Power Modules A module that provides an additional power supply if the system is using more 
peripherals than can be serviced by the panel power supply.  

 

CS507 Output 
Expanders 

An expander board that increases the number of outputs that can be used with 
the control panel.  

 



 

Term Definition  
CS534 Listen-in Module A two-way audio voice communicator. If the control panel communicates an alarm, 

the audio module allows the central station to establish a two-way session or 
monitor the premises for listen-in purposes. 

 

CS535 Voice Module A module used to send pre-recorded voice messages when activated.  
CS586 Direct Connect 
Module 

A menu optional device used to interface the up/download software directly to the 
control panel when the on board serial port is not available. 

 

CS7001 GSM Module A module that operates as a back up reporting module to the control panel.   
Current Operator A menu option that displays the current GSM network operator that the GSM 

module is logged into.  
 

Custom Message A keypad setting that shows or hides the custom message on the LCD keypad. 
(Display) 
A menu option that edits the custom message. (Text) 

 

Custom Message Lock A keypad setting that prevents the customized keypad message being edited.  
D    
Date of holidays A menu option that sets the date on which the specific output events are active. 

Up to eight days per month can be specified. This is a CS507 output expander 
option.  

 

DC Direct Current. An electric current that flows in one direction only from negative to 
positive. 

 

Default codes Codes that are supplied with the system. These are country specific.  
See also Country Code 

 

Default Settings A menu option that defaults the selected component (for example, the control 
panel or output module) to factory defaults. This is a necessary procedure on all 
components before starting to program the system.  

 

Delay 1 A zone type whose events can be delayed for a specified interval before a zone 
creates an alarm. This type of zone is usually used to allow exit and entry to a 
building. The time intervals for a Delay 1 zone are defined in Entry 1 and Exit 1.  

 

Delay 2 A zone type whose events can be delayed for a specified interval before a zone 
creates an alarm. This type of zone is usually used to allow exit and entry to a 
building. The time intervals for a Delay 2 zone are defined in Entry 2 and Exit 2. 

 

Device/Location 
Programming 

A menu command that switches into backward compatible programming mode. 
This mode uses devices, locations and segments. 
In this mode: 
The OK/Menu key is used instead of the * key. 
The F2 key is used instead of the Exit key.  
See the Installer Manual for more information. 
Please note that the recommended programming method is to use the menu 
structure rather than devices and locations.  

 

Diagnostics A menu entry that groups test options. These options specify the tests that can be 
performed on the control panel.  

 

Dial Attempts A menu option that specifies the number of dial attempts that the GSM module 
makes when reporting an event to the central station. (CS7001 GSM Module) 
A menu entry that groups options related to the number of dial attempts that the 
dialler makes when communicating with the central station. (Communications) 

 

Dialler Abort Delay A menu option that creates a delay, programmed in seconds, in reporting an alarm 
to the central station.  

 

Dialler Delay A menu option that sets the length of time (in seconds) the dialler waits before 
reporting an abortable alarm. If the system is disarmed during this time, the 
abortable alarm is not sent to the central station. The delay can be from 0-255 
seconds. A value of 0 means that there is no abort delay. 

 

Dialler Output Level A menu option that sets the volume of the output tone. The Dialler Output Level 
can only be used in combination with the stand-alone ISDN dialler TDA2001. 

 

Ding Dong Chime A menu option that sets the sound a chime makes. It is either a ding dong or a 
beep. (This Keypad) 
A menu option that enables a ding dong chime. (CS1700 Proximity Readers) 

 



 

Term Definition  
Direct Connect Module See CS586 Direct Connect Module  
Disable on Listen-in A menu option that disables the selected output during listen-in time. This option 

is normally used to silence sirens during listen-in. After the listen-in session, the 
sirens are activated again.  

 

Disarm A menu option that enables the disarm function for the selected proximity reader 
action. The actions are Single Badge, Double Badge and Badge Hold.  

 

Disarmed The security system is off in a particular area.  
Display A menu entry that groups LCD display options for the keypad.   
Do Self Test A menu command that performs the keypad LED and LCD test and the manual 

tests enabled in Diagnostics. The siren is activated during the tests if the Manual 
Siren menu option is enabled. Likewise, a manual test call is made to the central 
station if the Manual Dialler Test menu option is enabled.     

 

Door Prop Time A menu option that sets the time that the door must be open before the buzzer on 
the proximity reader is activated. This is to warn the user to close the door.  

 

Door Prop Zone A zone type that is used with the proximity reader. Alarms such as ‘Open too long’ 
are generated on this zone type.  

 

Door/Window A menu option that configures door/window settings on an RF 433 Mhz receiver. 
It includes the use of internal reed and additional external contact of the 
door/windows transmitters.  

 

Door/window 
transmitters 

Wireless sensors used on doors and windows. They are programmed as RF 
zones. 

 

Double Badge A menu entry that groups the functions activated by holding a proximity card 
against the proximity reader twice within the time set in Badge Double/Hold Time. 
(Badge Functions)  
A menu option that sets the X-10 function sent when a proximity card is held 
against the proximity reader twice within the time set in Badge Double/Hold Time. 
(X-10 Functions) 

 

Double Knock A zone characteristic that causes an event only if the zone is activated twice within 
a specified time. This is to prevent false alarms on PIRs.   

 

Double Knock Open 
Time 

A menu option that sets the double knock open time. If a double knock zone 
remains open longer than this time, an alarm is activated.  

 

Double Knock Time A menu option that sets the double knock time. If a double knock zone is opened 
twice within this time, an alarm is activated.  

 

Download The process of sending programming information or data on the panel to a 
computer running up/download software or to the central station.  

 

Download Settings A menu option that prevents the installer changing the following download 
settings:  
• Answer Machine Defeat 
• Call Back Req’d 
• Lockout>System Shutdown 
• Lockout>Local Programming 
• Lockout>Comms Settings 
• Lockout>Download Settings 
• Call PC on Autotest 
This option must be set through the up/download software.  
See also Lockout  

 

DSR Timeout A menu option that sets the dialler successful reporting timeout. If the panel dialler 
does not report successfully within this time period, the GSM module reports the 
events as a backup.   

 

Dual in-line package 
(DIP) 

A small rectangular housing containing one or more miniature switches used for 
setting device IDs. 

 

Duress A menu entry that groups the report codes sent for a duress event. 
A duress situation is one in which a user is being threatened and forced to disarm 
the system. A duress code is entered to disarm the system as normal and a 
duress alarm is activated. 

 



 

Term Definition  
Duress Code A code that disarms the system and activates a duress alarm. This is a silent 

alarm that sends a special report to the central station. 
 

Dynamic Batt Test at 
Arming 

A menu option that enables a dynamic battery test at arming. This is an automatic 
test carried out by the control panel at the moment of arming to ensure the battery 
is working properly. The panel lowers the battery charging voltage in order to draw 
current from the battery. If the system is not armed between 00:01 and 23:59, the 
test is performed at 00:00. 

 

E    
Emergency keys See Combination keys  
End Download A menu option that sends a report to the central station when downloading from 

the up/download software to the control panel is complete. (System Reports) 
A menu entry that groups the report codes sent to the central station when 
downloading is complete. (Report Codes) 

 

End of Line Resistor A zone characteristic that specifies that two 4K7 end of line resistors are used.  
An end of line resistor (EOL) is a resistor that is placed on the line to stop the 
signal being bounced back.  

 

End Programming  A menu entry that groups the report codes that are sent to the central station when 
the installer leaves programming mode. 
See also Start/End Programming 

 

Enrol Modules A menu option that activates the process by which the control makes an internal 
list of all keypads and modules connected to the system. 

 

Enter Code or OK A menu option that enables the menu prompt ‘Enter Code or OK’.   
Entry 1 The time within which the user must disarm the system before a full alarm occurs. 

This time can be between 10 and 255 seconds.  
See also Delay 1 

 

Entry 2 The time within which the user must disarm the system before a full alarm occurs. 
This time can be between 10 and 255 seconds. 
See also Delay 2 

 

Entry Guard A zone type that reduces false alarms. If an armed entry guard zone is opened, 
the keypad sounder activates and the entry delay starts before creating an alarm.  
This can be programmed as a zone type. 

 

Entry route The route the user must follow through a secured area to reach the keypad and 
disarm the system. 

 

Entry time buzzer An audio indicator that sounds during all entry times.  
EOL resistor See End of Line Resistor  
Event Any occurrence such as system arming, faults and alarms. 

A menu option that specifies which event activates an output.  
 

Event Log 
  
  

A menu command that is used to view the event log. The event log is a list of 
events that occur in the system, regardless of the armed state of the system. They 
are held in a sequential event buffer with a time and date stamp. When the log is 
full, it overwrites the oldest entries with new data. These events can later be 
viewed through downloading.  
See also Log Full 

 

Events  A menu entry that groups settings that control which events are reported for phone 
communication. 

 

Exit 1 The time within which the user must leave the protected zone after arming the 
system before a full alarm occurs. This time can be between 10 and 255 seconds.
See also Delay 1 

 

Exit 2 The time within which the user must leave the protected zone after arming the 
system before a full alarm occurs. This time can be between 10 and 255 seconds. 
See also Delay 2 

 



 

Term Definition  
Exit Error A menu option that specifies that the control panel sends an exit error report if an 

entry/exit zone is faulted when the exit delay expires. This report is sent along with 
the user number that armed the system, if the panel is not disarmed before the 
entry delay expires. The alarm report is also sent. Even if this feature is not 
enabled, the siren sounds if any entry/exit zone is faulted when the exit delay 
expires.   
A menu entry that groups the report codes sent to the central station if an alarm is 
created during the exit time. (Report Codes) 

 

Exit Expiry A menu option that causes the internal sounder to blast when the exit time 
expires. 

 

Exit route The route the user must follow to exit a secured area after arming the system.  
Exit time The time within which the user must exit the secured area after arming the system 

before a full alarm occurs. This time can be between 10 and 255 seconds. 
 

Exit time buzzer A sounder indicating that the system is in exit time waiting to complete arming. 
The exit time buzzer does not sound for silent exit.   

 

Expander board The control panel can be used with additional boards which provide extra 
functionality. 
These include: 
• CS208/CS216 Input Expanders 
• CS507 Output Expanders 
• CS586 Direct Connect Module 
• CS534 Listen-in Module 
• CS320 Power Modules 
• CS535 Voice Module 
• CS1700 Proximity Readers 
• CS7001 GSM Module  
• Receiver Modules  

 

Expander Trouble A menu option that activates the internal sound when an expander trouble 
condition occurs. (Internal Siren)  
A menu option that activates the keypad buzzer when an expander trouble 
condition occurs. (Keypads) 
A menu option that sends a report to the central station when an expander trouble 
condition occurs. (System Reports) 
A menu entry that groups report codes sent to the central station when an 
expander trouble event occurs. (Report Codes) 

 

Expander Trouble and 
Restores 

A menu option that sends a report to the central station when the control panel 
detects expander trouble. A report is also sent when the trouble condition is fixed. 
(Reports) 
A menu option that sends an expander trouble and restore report to the selected 
phone number. (Phone Numbers) 
A menu option that sends expander trouble and restore reports to the central 
station depending on the condition of the panel dialler. (CS7001 GSM Module) 
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

Expansion modules See Expander board  
External Contact A menu option on an RF door/window sensor that enables an additional external 

contact. When the external contact is triggered, an alarm is generated on the 
same zone number as the door/window sensor (reed contact) itself.  

 

External Siren Timeout A menu option that sets the length of time an external sounder/siren rings before 
automatically cutting out. A new alarm trip reactivates the external sounder for the 
length of time specified in this option. This time can be between 0 and 255 
minutes. When set to 0, the siren is active until a valid code is entered on the 
keypad. 

 

F    



 

Term Definition  
Factory defaults The default control panel values that are set in the factory. Each country has a 

country code and associated default values. To use these values, default the 
panel and then select the country code. The default values are filled into the 
control panel the moment the country code is selected. 

 

Fail to Communicate  A menu option that sends a report to the central station when the system has 
failed to communicate with the central station after the number of attempts set in 
FTC Dialler Attempts. The report is sent when communication with the central 
station has been restored. (System Reports) 
A menu option that reports a fail to communicate event to the selected phone 
number. (Phone Numbers) 
A menu entry that groups the report codes sent to the central station when a fail to 
communicate event occurs. (Report Codes) 
A menu option that reports a fail to communicate event to the central station 
depending on the condition of the panel dialler. (CS7001 GSM Module) 
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

Fast Format Channels A menu option that specifies which Fast Format channels are enabled. These are 
grouped as Channels 1 – 8 and Channels 9 – 16.  

 

Faults Any problems with the system. Zones that are open are referred to as faulted.  
Feature Select A menu entry that groups all optional features relating to partition settings, control 

panel system settings and so on.  
 

FF Channel A menu option that specifies that the Fast Format channel format is used to report 
the selected zone, zone type or event. 

 

File n A menu option that selects the programming memories within the CS586 direct 
connect module. There are four possible programming memories.  

 

File to Panel A menu option to copy programming memory from one of the four memory 
locations contained in the CS586 direct connect module, to the control panel.  

 

Files A menu entry that groups the four programming memories in the CS586 direct 
connect module.  

 

Final Set Door  A zone type that arms the system the moment the exit door is closed. It differs 
from an exit terminator zone in that it is available in the standard CSx75 and is 
attached to a zone that can also create alarms and so on.  

 

Fire A zone type that reports a fire alarm when activated.   
Fire light An LED light indicating the status of a fire zone. A steady fire light means a fire 

zone has been faulted. A rapidly flashing fire light means that a fire zone is in a 
trouble condition.  

 

Fire Siren A menu option that sets the type of siren activated when a fire alarm occurs. This 
can be either yelping or temporal.  

 

Fire Supervision  A menu option that specifies that the RF433 or RF868 receiver uses the fire 
supervision timing window.    

 

Fire Verification Time A menu option that sets the amount of time within which a second trip must occur 
on a smoke detector in order to generate an alarm. 

 

Fire Window A menu option that specifies the RF supervision to be used for RF smoke/fire 
detectors. The RF smoke/fire detectors send a supervision every 64 minutes, 
irrespective of 433 Mhz or 868 Mhz. 
See also Supervision  

 

Fire/Aux 1 (1+3) A menu option that activates keys 1 and 3 as the fire alarm combination keys. 
When this option is enabled and these keys are pressed at the same time, a fire 
alarm is generated.  

 

First to Open/Last to 
Close 

A menu option that sends a report to the central station stating when the system 
opened and closed. This option can only be used in a multi-partitioned system. 
A report is sent stating the first area opened. A log is then kept recording when the 
other areas opened and when they closed. This information is sent in a second 
report when the last open area closes.  

 



 

Term Definition  
Fn Function 
 

A menu option that specifies the function of the selected function key. Possible 
functions are:  
• Arm Away (asks for code if quick arm disabled) 
• Arm Stay  
• Bypass Zones (asks for code if required for bypass) 
• Group Bypass  
• X-10 Device Control (start up X-10 device control mode) 
• Alarm Memory  
• Service Check  
• Reset Smoke Detector  
• Answer U/D Call (asks for code if required for download) 
• Begin U/D Call  
• Silent Exit  
• Chime  
• PA Alarm  
• MA Alarm  
• Fire Alarm  
• Change Phone Number (asks for code, which must be a master code, and 

prompts for the phone number to change) 
See also User Phone Editing  

 

Follower/Access A zone type that acts like a normal burglary zone except during entry and exit 
times when it is inhibited. The entry time is started when a Delay zone is opened. 
The zone is instant when the system is armed and no entry or exit delay is timed. 
See also Delay 1 and Delay 2 

 

For Zones On Siren 
Timeout 

A menu option that sends a restore report to the central station when the siren 
times out. 
See also Send Restores 

 

Force Armable A zone characteristic that allows the zone to be force armed.  
Force arming A feature of the CSx75 which allows the system to be armed with open zones. If a 

force armable zone is open, the Ready LED flashes. When the exit delay expires, 
the open zones are bypassed. If these zones are closed during the arming cycle, 
they are unbypassed and become armed.  
See also Bypass on Force Arm and Force Armable 

 

Force Default Zone 
Types 

A menu option that uses the default zone types in the country defaults for the 
selected country rather than configured zone types.  

 

Format Override A menu option that allows the installer to build communication formats if using a 
non-standard central station. Consult technical support before using this option.   

 

FTC See Fail to Communicate  
FTC Dial Attempts A menu entry that groups options related to the number of attempts that are made 

to a specified phone number, before the Fail To Communicate condition appears. 
(Communications) 
A menu option that specifies the number of dial attempts that are made by the 
GSM module to a specified phone number, before the Fail To Communicate 
condition appears. (CS7001 GSM Module)  

 

Full arm All of the possible areas displayed on a multi-area keypad are armed.  
Function Keys A menu entry that groups all programmable function key options.  

Function keys are dedicated for a particular function as programmed by the 
installer.  

 

Functions A menu entry that groups the functions that can be linked between a CS1700 
proximity reader and X-10 functions.  

 

G    
Group Bypass 
  

A zone characteristic that allows the user to bypass multiple zones with a single 
operation.  

 

Group Shunt  See Group Bypass  



 

Term Definition  
GSM Connection A menu entry that groups GSM connection settings.   
GSM Engine Info A menu entry that groups information that is returned from the on-board GSM 

module on the CS7001 GSM module.  
 

GSM Module See CS7001 GSM Module   
GSM Operator A menu entry that groups information on the current GSM operator and allows a 

specific GSM operator to be manually selected.  
See the GSM Module Installation Manual (CS7001) for more information.  

 

GSM Engine Comms A menu option that indicates that communication with the GSM module is 
established.  

 

H    
Handshake Digit A menu option that specifies the handshake digit. This digit is sent from the central 

station (in the case of a CS535 voice module, this is usually a house phone or a 
mobile phone) to the control panel in order to establish a connection.  

 

Hardware zone expander See CS208/CS216 Input Expanders  
Hide PINs A menu option that displays the user code as dashes when programming codes 

using the keypad. If this option is disabled, each digit is shown rather than 
displayed as a dash.  

 

High Gain Listen In  A menu option that activates high gain listen-in mode. This is a listen-in mode that 
is generally used in environments that produce very low noise.  

 

Home Automation A menu entry that groups options relating to the home automation system. 
The control panel can communicate to home automation protocols such as the    
X-10 protocol. The connection between the control panel and the X-10 home 
automation module is made through the CS507 output expander or the CS534 
listen-in module RJ11 connectors. The on-board RS232 connector on the CS275, 
CS575 and CS875 can be used to connect to other home automation systems.  
Consult your local Aritech Support to obtain more information. 

 

House Code A menu option that sets the code used to identify a particular premises. It is 
necessary in case any neighbouring premises also has an X-10 home automation 
system.  
More information on the X-10 home automation system can be found at www.x-
10europe.com. 

 

I    
Indicator-A Time 
Remaining 

A menu option that sets the length of time remaining after indicator “A” is sent to 
the central station. The two-way session is terminated after this time if there is no 
further activity from the central station. This time can be set between 1 and 255 
seconds. This is a CS534 listen-in module option. 

 

Indicator-B Time 
Remaining 

A menu option that sets the length of time remaining after indicator “B” is sent to 
the central station. The two-way session is terminated after this time if there is no 
further activity from the central station. This time can be set between 1 and 255 
seconds. This is a CS534 listen-in module option. 

 

Input Type A menu entry that groups options that determine the basic features of the selected 
zone type. 

 

Inputs A menu entry that groups options relating to all zones. (Control Panel) 
A menu entry that groups options relating to RF zones only. (RF Receivers) 
A menu entry that groups time settings relating to inputs.   (System 
Settings>Timers) 
A menu entry that groups options that enable features relating to inputs. (System 
Settings>Feature Select) 

 

Installer The person who installs and programs the system.   
Installer Code A four or six-digit code used to program the system. It specifies the partitions and 

parts of the system the installer can access. It can also be used as a standard 
arm/disarm code, in which case it becomes user 255.  
A menu entry that groups installer code options. 

 

Installer Menu A menu entry that groups all information related to installer programming.   



 

Term Definition  
Interface Configuration A menu option that enables interface configuration transition broadcasts. These 

broadcasts transmit changes to zones, partitions and so on to the home 
automation system. (Transition Broadcasts) 
A menu option that enables the control panel to respond to interface configuration 
requests sent by the home automation system. (Commands/Requests) 

 

Interior A zone type within the building that is bypassed when the system is armed in stay 
mode.  

 

Internal Reed A menu option on an RF door/window sensor that enables the internal reed 
contact.  

 

Internal Siren A menu entry that groups options that set the conditions/events that activate the 
internal siren. This is a siren which sounds within the building. 

 

Internal Siren Timeout A menu option that sets the length of time the internal siren rings before 
automatically cutting out. This time can be between 0 and 255 minutes. When set 
to 0, the siren is active until a valid code is entered on the keypad. 

 

Internal sounder See Internal Siren  
Interval A menu option that sets the length of time between autotests. The unit is set in 

autotest control. The Hour and Minute options set the time at which the test is 
performed.  

 

Inverted A menu option that enables a mode that inverts the state of an output (normally 
activated and then deactivated when an event occurs).  
A menu option that lights the selected LED (Green/Red) when the device is in 
inverted mode. (CS1700 Proximity Reader) 

 

J   
Jam Detection A menu option that enables the detection of RF jamming. The RF wireless 

communication is considered to be jammed when there has been a jamming 
signal for more than 30 seconds in a 60 second window.  

 

K    
Key click The default sound for any key press.  
Keychain touchpads See Keyfob  
Keyfob A menu entry that groups options relating to any device that sends commands by 

a wireless receiver.  
 

Keyfob Funct 1 A menu option that enables the light bulb button on the keyfob for the selected RF 
zone on the selected RF receiver. If this option is enabled, pressing the light bulb 
button sends a keyfob function 1 event. Control panel auxiliary outputs and CS507 
outputs can be programmed to respond to this event. (RF Receivers)  
A menu option that sends a keyfob function 1 event for the selected proximity 
reader action. The actions are Single Badge, Double Badge and Badge Hold. 
(CS1700 Proximity Readers) 

 

Keyfob Funct 2 
 

A menu option that enables the * button on the keyfob for the selected RF zone on 
the selected RF receiver. If this option is enabled, pressing the * button sends a 
keyfob function 2 event. Control panel auxiliary outputs and CS507 outputs can be 
programmed to respond to this event. (RF Receivers)  
A menu option that sends a keyfob function 2 event for the selected proximity 
reader action. The actions are Single Badge, Double Badge and Badge Hold. 
(CS1700 Proximity Readers) 

 

Keyfob Low Battery 
Reports 

A menu option that reports a keyfob low battery condition. This option is available 
on the 868 Mhz RF Receiver only.  
The low battery condition is reset by pressing the Arm (Lock) and Disarm (Unlock) 
button at the same time. If this option is enabled, each enrolled keyfob uses up 
one zone in the system. If this option is disabled, keyfobs do not use up a zone in 
the system and can overlap with a used zone.  

 

Keyfob User ID A menu option that makes the keyfob report as the zone that it is learned into. 
When this option is disabled, all keyfobs report their open/closing reports as user 
99.  

 



 

Term Definition  
Keypad A device used to interface with the system. 

A menu entry that groups the report codes sent to the central station for keypad 
related events.  

 

Keypad activated panics See Combination keys   
Keypad Aux 1 (Fire) A menu entry that groups the report codes sent for the keypad aux 1 (fire) event. 

See also Combination keys  
 

Keypad Aux 2 (Medical) A menu entry that groups the report codes sent for the keypad aux 2 (medical) 
event. 
See also Combination keys  

 

Keypad Beeping A menu option that activates the keypad buzzer when an alarm occurs.  
Keypad Defaults A menu option that defaults the keypad to the country settings for the selected 

country. 
 

Keypad display The keypad screen where system message, menu options and user/installer input 
are displayed.  

 

Keypad Features Options that define keypad features: 
• Display 
• Sounds 
• Case Tamper 
• Multi-Area Keypad 
• Panic Keys 
• User Phone Editing 

 

Keypad Functions A menu entry that groups settings that enable home automation commands 
related to keypads.  

 

Keypad Message A menu option that allows the home automation protocol to send different end-
user messages to the keypad display.  

 

Keypad Number A menu option that sets the keypad number within the partition. The keypad can 
be numbered from one to eight. The selected number links to the module number 
reported to the central station in the case of tampers or expansion troubles. An 
overview of the keypad numbers and their module numbers can found in 
appendix 2 of the CS5500 Programming Manual.  

 

Keypad Panic A menu entry that groups the report codes sent for the keypad panic event.  
Keypad Tamper A menu entry that groups the report codes sent for the keypad tamper event.  
Keypad Terminal Mode A menu option that makes the keypad a home automation terminal when 

requested by the CS586 direct connect module. 
 

Keypads A menu entry that groups the keypad events that trigger an output. (Event)  
Keyswitch  A zone type that can be used to arm or disarm a partition using a switch 

connected to a zone instead of a code. Both pulsed and maintained keyswitches 
can be used. 

 

Keyswitch Arming A menu option that causes the internal sounder to blast when the system is armed 
by keyswitch or armed and disarmed by keyswitch. There is one blast for arming 
and two blasts for disarming. 

 

Keyword library See Word library  
Kiss off  An audio signal sent by a central station receiver to the modem on the control 

panel indicating that it has received the communicator’s transmission successfully.
 

Kiss Off Digit A menu option that specifies the digit that the CS535 voice module accepts as a 
signal from the telephone saying that the person has understood the message.  

 

Kiss Off Message A menu command that records the kiss off message. This message is sent by the 
CS535 voice module at the end of a voice reporting phone call to indicate that the 
kiss off digit has been received.  (Recording) 
A menu command that plays back the kiss off message. (Playback)  

 

L    
Language Text A menu entry that groups descriptors such as Custom Message and Shutdown 

Message. These messages are language independent.  
 



 

Term Definition  
Last Round Count A menu option that displays the number of rounds of RF data received during the 

last transmission. This information can provide an indication of the quality of data 
reception. To get an accurate count, the installer must cause a tamper and then 
wait 5 seconds before restoring the tamper to prevent additional signals being 
counted. This option is available only on a 433 Mhz system and is replaced by the 
RSSI value on an 868 Mhz system.  

 

Latched A menu option that causes an output to remain activated until a code is entered at 
the keypad. 

 

LCD contrast The contrast of the LCD display. This can be changed for each individual keypad.  
LCD keypad A device used to interface with the system. Information is displayed on an LCD 

display.  
 

LCD Keypad Address A menu option that specifies the unique number that is assigned to the keypad 
when it is enrolled. The system uses this address to identify the keypad. It is also 
used to report events (such as keypad tampers and keypad communication loss) 
to the central station.   

 

Leader Message A menu command that records the leader message. This message is sent by the 
CS535 voice module at the start of a voice reporting phone call. (Recording) 
A menu command that plays back the leader message. (Playback) 

 

Learn-in Mode An option that enables the mode in which a new wireless device is enrolled on the 
system. 

 

LED 1 (Green) A menu entry that groups options that cause LED 1 to display a green light. The 
CS1700 proximity reader has a built-in LED (at the top of the reader) which can 
display a green light or be turned off.  
The LED follows the ready state or the state of the built-in relay in the proximity 
reader. It is possible to invert the action that activates the LED.  

 

LED 2 (Red) A menu entry that groups options that cause LED 2 to display a red light. The 
CS1700 proximity reader has a built-in LED (at the bottom of the reader) which 
can display a red light or be turned off.  
The LED follows the armed state or the state of the built-in relay in the proximity 
reader. It is possible to invert the action that activates the LED. 

 

LED Extinguish 
  

A menu option that turns off all LEDs on the keypad (except the Power LED) after 
60 seconds without a key press. All LEDs are illuminated again when any key is 
pressed. 
A menu option that enables or disables LED Extinguish for all partitions. 
(Partitions) 
A menu option that enables or disables LED Extinguish for an individual keypad. 
Both options must be enabled for this feature to work. (Keypad) 

 

LED keypad A device used to interface with the system. Information is displayed using LED 
lights.  

 

Light control A control used with the home automation system to set the level of lighting on the 
premises. 

 

Light Emitting Diode 
(LED) 

A light on the keypad that gives system status information.  

Line Fault Delay A menu option that specifies the number of seconds that the RF signal (GSM 
module) must be lower then the level defined in Line Fault RF Level in order to 
signal a line fault. This option is related to the CS7001 GSM module. 

 

Line Fault RF Level A menu option that specifies the detection level of the RF signal. If the RF signal 
is lower then this value, a line fault is generated.  

 

Line Hold Digit A menu option that specifies the digit that starts a two-way session when the 
control panel is in line hold mode. This is a CS534 listen-in module option. 

 

Line hold mode A mode that allows the CS534 listen-in module to seize the line immediately after 
the control panel releases the line. A two-way session with the central station 
begins instantly or when the line hold access digit is entered depending on how 
the audio module is programmed.  

 



 

Term Definition  
Line Hold Timeout A menu option that sets the length of time the CS534 listen-in module will remain 

on the phone line with no activity from the central station. This time can be set 
from 30 to 255 seconds. If it does not receive the digit within this time, the listen-in 
module disconnects. 

 

Liquid Crystal Display 
(LCD) 

See Keypad display  

Listen-in A menu option that sends a report to the central station indicating that a listen-in 
session must be started.  
Listen-in is a user function. In order to use listen-in, a CS534 listen-in module must 
be installed and a microphone must be connected. When an alarm is generated 
and reported, the central station can listen to what is happening on the premises. 
Certain protocols (such as SIA, Contact ID and 200Bd FSK) have ‘listen-in blocks’ 
that are communicated with the alarm code and indicate that a listen-in session 
must be started.  

 

Listen-in Module See CS534 Listen-in Module  
Listen-In Only A menu option that enables the listen-in only mode. This is the mode in which the 

central station can monitor sounds at the customer's premises but cannot 
establish two-way communication.  
See High Gain Listen In and Low Gain Listen In  

 

Listen-in Time 
  

A menu option that sets the length of time the central station can listen for sounds 
of intrusion by means of microphones at the alarm site.  

 

Local Only  A zone characteristic that causes that zone not to report alarms to the central 
station. Locally, the sirens are activated according to the other zone type 
characteristics.  

 

Local Programming A menu option that disables the installer menu. This option can be set only 
through the up/download software.  

 

Location A programmable unit of a module.  Different options can be specified for each 
location. Each location contains one or more segments. Locations are 
programmed on the CS5500 menu keypad using menu options. 

 

Lockout A menu entry that groups options that lock certain system functions.  
See also System Shutdown, Local Programming, Comms Settings and Download 
Settings 

 

Log Event A menu option that causes the selected output to log an event when it is activated. 
This is available only on the CS507 output expander module. (Outputs) 
A menu option that enables log event transition broadcasts. (Transition 
Broadcasts) 
A menu option that causes the control panel to log an event each time an output 
on the CS507 output expander module trips and each time an output restores. 
(Commands/Requests) 

 

Log Full  A menu option that sends a report to the central station when the event log is full. 
(System Reports) 
A menu entry that groups the report codes sent to the central station when the 
event log is full. (Report Codes) 

 

Logged into GSM 
Network 

A menu option that indicates that the CS7001 GSM module is logged into the 
GSM network.  

 

Loop Response A zone characteristic of on-board control panel zones that specifies the response 
rate. This can be either 500 ms or 50 ms.  

 

Lost Clock Indication A menu option that enables the service message ‘Control Loss of time'. See 
appendix 5 in the CS5500 Programming Manual for a list of all service messages. 

 



 

Term Definition  
Low Battery A menu option that sounds keypad buzzers when a low battery event occurs. 

(Sound On) 
A menu option that enables low battery reporting on the control panel.  (System 
Reports) 
A menu entry that groups report codes sent to the central station for a low battery 
event. A restore report is sent to the central station when this condition is no 
longer active. (Report Codes) 
A menu option that enables low battery reporting on a CS320 power module. 
(CS320 Power Module) 

 

Low Gain Listen In An option that enables the mode in which the central station listens in to the 
customer’s premises. This mode is used in environments where background noise 
may distort the audio.  

 

M    
Mains The main source of power.  
Mains Delay Time A menu option that sets the length of time between detecting a mains failure on a 

CS320 power module and sending a report to the central station. The restore 
event is sent four minutes after the mains is restored.  

 

Mains Failure  A menu option that causes the keypad sounder to buzz when the mains power 
supply fails. (Keypads) 
A menu option that sends a report to the central station when the mains power 
supply fails. A delay time can be set for this report. (System Reports)  
A menu entry that groups the codes used to report a mains failure event. (Report 
Codes) 

 

Mains Frequency A menu option that provides an accurate clock in situations where different mains 
frequencies are used: 50 Hz or 60 Hz are possible selections.  

 

Mains Report Delay A menu option that sets the length of time between detecting a mains failure on 
the control panel and sending a report to the central station. The restore event is 
sent four minutes after the mains is restored.  

 

Mains/Batt Sounder 
Alert 

A menu option that causes the keypad sounder to beep upon arming or disarming 
if the mains power is missing or a low battery is detected. (System option) 

 

Manual Dialler Test A menu option that includes a dialler test in the user’s manual test. A manual test 
call is made to the central station and the corresponding signal is transmitted. 
See also Do Self Test  

 

Manual Siren Test A menu option that activates the siren test when the Do Self Test command is 
selected from the User menu.  

 

Manual test A bell and/or communicator test that can be manually performed while the system 
is disarmed.  

 

Manufacturer A menu option that contains the GSM Engine Manufacturer Identification. For the 
CS7001 GSM module, this is a Siemens GSM engine.  

 

Master Code A menu option that specifies a code that can program other user codes provided it 
has access to the same partitions as the user code. The user 1 code is the default 
master code. 

 

Master Code Resets 
Tamper Memory 

A menu option that allows a master user to reset the system after a tamper alarm. 
If this option is disabled, an installer must reset the system each time a tamper 
occurs. The user should identify the cause of the alarm before arming the system 
and contact the installer if necessary. 
See also Service Check and Service Message 

 

Master mode See Multi-Area Keypad  
Master mode display The high level display when in the master mode. It shows the armed and ready 

state of all areas in the system. 
 

Master user A user who has been assigned master user attributes. A master user can create 
other users in the system.  

 

Max SMS Messages A menu option that specifies the maximum number of text messages that the 
CS7001 GSM module can send to the central station. The maximum number of 
text messages is calculated over a period of 24 hours, between 0:00 and 23:59.  

 



 

Term Definition  
Medical/Aux 2 (4+6) A menu option that activates keys 4 and 6 as the medical alarm combination 

keys. When this option is enabled and these keys are pressed at the same time, a 
medical alarm is generated. 

 

Mic A at Startup A menu option that activates microphone A when listen-in commences.  
Mic B at Startup A menu option that activates microphone B when listen-in commences.  
Misc Commands A menu entry that groups home automation commands.   
Misc Requests A menu entry that groups home automation requests.   
Mode A menu option that specifies if the CS534 listen-in module is used in line hold 

mode or call back mode.  
See the Installation Manual for more information.  

 

Model A menu option that displays the current model of the device being programmed.   
Module The system is divided into modules. For example, the control panel is one module 

and the keypad is one module. Each module stores its own configuration which 
can be accessed through the Installer menu. A module is also known as a device.  

 

Module Number A menu option that sets the X-10 module number used to identify a particular X-10 
device on the selected module.  
A CSx75 bus module number is assigned to each system module. The system 
uses this number to identify the module. It is also used to report module problems 
(such as tampers and module supervision lost) to the central station. 

 

Multi Code Tamper A menu option that disables the keypad for 60 seconds and sends a tamper signal 
to the central station if 30 key presses are entered without producing a valid code.  

 

Multi-area arm The system is armed for multiple areas at once.  
Multi-area disarm The system is disarmed for multiple areas at once.  
Multi-Area Keypad A menu option that sets the default mode of the selected keypad to multi-area 

mode. This is a mode of operation on a keypad that allows a user or installer 
access multiple partitions within the system and to perform functions in these 
partitions.  
A multi-area keypad can be temporarily switched to operate in single-area mode 
and a single-area keypad can be temporarily switched to operate in multi-area 
mode.   

 

Multi-partition mode See Multi-Area Keypad  
Multiple Event 
Messages 

A menu command that records a multiple event message. This message is sent 
by the CS535 voice module and states the events that have occurred. 
(Recording) 
A menu command that plays back multiple event messages in a row. (Playback) 

 

N    
New Trip Hangup Time A menu option that sets the time at which the two-way session timer is reset if a 

new event occurs in a partition during a two-way session between the partition and 
the central station.   

 

No Keypad Display A zone characteristic that blanks the zone status when armed.  
Normal Window Normal window: A menu option that specifies the normal supervision window for 

RF devices. RF devices on 433 Mhz typically report every 64 minutes. RF devices 
on 868 Mhz typically report every 15 minutes. Depending on the country 
regulations, this timer must be set to specific values.  
See the Installation Manual for more information. 
See also Supervision 

 

Numeral keys Keypad keys that are used to enter numeric values, including codes and settings, 
to the control panel.  

 

O    
On-board 8 zones A menu option that disables the zones on the control panel. This provides a 

completely wireless alarm system. 
 

Only if Closed A menu option that activates an output after closing time and before opening time. 
During these times, codes can be used to arm/disarm the system. A timer is used 
to set these times. 

 



 

Term Definition  
Only if Open A menu option that causes an output to activate only if the programmed event 

occurs between the opening and closing time of a schedule. 
 

Open zone A detection area that is not secured. An open zone makes the system status ‘Not 
Ready’. An example of an open zone is a protected door or window that is open. 

 

Open/Close/Cancel A menu entry that groups all reporting codes for opening, closing and cancel 
events. 

 

Opening  A menu option that sets the time at which the selected schedule enters the open 
state. (Schedules) 
A menu option that sets the time at which the selected schedule enters the open 
state. At this time, the control panel enables codes designated as ‘arm only after 
closing’. (Schedule Times)  
A menu entry that groups the codes reported on an opening (disarm) event. 
(Report Codes) 

 

Opening/Closings A menu option that sends a report to the selected phone number stating when the 
system is opened (disarmed) and closed (armed). (Arm/Disarm/Alarm) 
A menu option that enables opening/closings reporting. (Reporting) 
A menu option that sends opening/closings reports to the central station 
depending on the condition of the panel dialler. (CS7001 GSM Module) 
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

Operator Selection A menu option that specifies which network to use with the CS7001 GSM module. 
The GSM module lists all operators and operator codes. A full list of operators can 
be found in the GSM Module Installation Manual (CS7001).  

 

Optical Tamper A menu option that sends a report to the central station when there is interference 
with the CS7100 proximity reader. The optical tamper is built in as a pry-off 
protection. 

 

Other keypads A menu entry that groups programming options for other keypads in the system. 
These options include changing keypad settings and verifying software version 
and models.  

 

Output Expanders See CS507 Output Expanders   
Output Signal Type A menu option that converts the internal siren to accept a speaker. The built-in 

112db siren driver can be converted to a 1-amp voltage output. The siren can be 
15 or 30 Watt maximum, with an impedance of 4, 8 or 16 ohms.  

 

Outputs A menu entry that groups options relating to programmable outputs. 
There are two types of outputs; relay and open collector. The control panel 
includes up to four auxiliary outputs. The CS507 output expander and the CS320 
power module provide additional outputs. 
A menu option that specifies which outputs the selected user can operate. (CS507 
Output Expander) 

 

P    
Panel Dialler Not OK 
Events 

A menu entry that groups events that are sent by the GSM when there is no 
telephone line available or when the dialler did not report correctly within the 
Dialler Successfully Reporting Time Out (DSRT) period. The GSM reports these 
events as a backup.   

 

Panel Dialler OK Events A menu entry that groups events that are sent by the GSM when the telephone 
line is available. If the telephone line on the panel is disconnected, the events are 
not sent.  

 

Panel to File A menu option to copy a panel’s programming to one of the programming 
memories in the CS586 Direct Connect module. There are four possible 
programming memories in the CS586. 

 

Panel Type A menu option that displays panel type information currently stored in one of the 
four programming memory files on the CS586 Direct Connect module. Possible 
values are CS175, CS275, CS575 and CS875. 

 

Panic alarm See Personal attack alarm  
Panic Keys A menu option that enables panic keys to be programmed. The CSx75 allows the 

user to generate different types of panic by pressing two keys at once.  
See also Combination keys 

 



 

Term Definition  
Partarm A menu option that groups the report codes sent to the central station when the 

system is partarmed (Arm Stay).  
See also Arm Stay mode 

 

Partition A group of zones which operate as a unit and can be armed and disarmed 
independently of other partitions in the system. A partition is also known as an 
area. The control panel can be divided into separate partitions with distinct zones, 
keypad and user codes for each partition. 
A menu option that specifies the partition that the selected keypad can access if it 
is a single-area keypad. It also, together with the keypad number, determines the 
keypad bus module number for both single-area and multi-area keypads.  
See also Module Number, Partitions, Multi-Area Keypad 

 

Partition Account Codes A menu option that specifies the account code for each partition. This option can 
be used only if the account code in one of the six phone numbers is left blank.  
See also Account Code  

 

Partition Names A menu option that specifies the name of each partition.  
Partition Reports A menu option that specifies the events that are enabled for each partition. 

Events specified in this option are related to all partitions in the system.  
 

Partition Settings A menu entry that groups all partition settings. These settings include partition 
features, partition timers and so on.  

 

Partition Snapshot 
 

A menu option that enables partition snapshot transition broadcasts. (Transition 
Broadcasts) 
A menu option that enables the control panel to respond to partition snapshot 
requests sent by the home automation system. (Commands/Requests) 

 

Partition Status 
 

A menu option that enables partition status transition broadcasts. (Transition 
Broadcasts) 
A menu option that enables the control panel to respond to partition status 
requests sent by the home automation system. (Commands/Requests) 

 

Partitioned system A system divided into multiple areas or partitions. Each partition can be 
programmed differently and can be controlled by a different user. 

 

Partitions A menu entry that lists the partitions assigned to the selected 
zone/output/keyfob/proximity reader. The selected zone/keyfob/proximity reader 
can trigger an event on these partitions. The selected output can be triggered by 
an event on these partitions. 
A zone may reside in any combination of partitions. A zone that resides in more 
than one partition becomes a common zone and is reported to its lowest partition 
number. A common zone is armed only when all the partitions that it belongs to 
are armed. It is disarmed the moment one of the partitions it belongs to is 
disarmed.  

 

Partitions Autoarming 
  
  

A menu option that allows the control panel to auto arm at a specified time. At this 
time, the keypad beeps for 50 seconds before the panel arms. The arming 
process is stopped if a code is entered on the keypad. The control panel attempts 
to arm after every 45 minutes of inactivity until the next opening time, or until the 
system is armed. The 45-minute timer is extended when there is activity in the 
building causing the Ready LED to turn off and on. If closing reports are sent, the 
user code is 97. 

 

Partitions Opening A menu option that specifies the days of the week that each partition is open.   
Perimeter The outer edge of the protected area. A perimeter alarm is an alarm that is 

activated on the perimeter rather than on an interior zone. 
 

Peripheral bus interface The bus on which modules are connected to the panel.  
Personal attack alarm An alarm that is reported when a personal attack zone is activated or when the 

combination keys for a personal attack alarm are pressed. A personal attack zone 
is a zone type that sends a personal attack alarm and it can be linked to a panic 
button. Generally, a silent alarm is sent to the central station.  
See also Combination keys  

 

Phone Account Code A menu option that specifies the phone account code. This is the default account 
on the CS7001 GSM module that is used for partitions with no account code.  

 



 

Term Definition  
Phone Line Cut  A menu option that sends a report is sent to the central station the moment the 

phone line cut is restored. If a CS7001 GSM module is installed, it may be 
configured to report the phone line cut straight away. (System Reports) 
A menu entry that groups options that activate the internal siren when a phone line 
is cut while armed or disarmed. (Internal Siren>Sounds On)  
A menu entry that groups options that activate the keypad buzzer when a phone 
line is cut while armed or disarmed. (Keypads>Sound On) 
A menu entry that groups the report codes sent when a phone line is cut. (Report 
Codes) 

 

Phone Line Cut Delay  A menu option that sets the length of time before a phone line cut is signalled after 
a phone line cut is detected. 

 

Phone Number A menu option that specifies the phone number of the central station where events 
are reported. The control panel can report to up to six phone numbers.   

 

Phone Numbers A menu entry that groups phone number reporting options.   
Phone Prefix A menu option that specifics the phone prefix. This is a four-digit telephone prefix 

that is used to select tone and pulse dialing and enter a delay to wait for a dial 
tone. This sequence is pre-dialled by each of the telephone numbers. 
#1 programs a *. 
#2 programs a #. 
#3 programs a four-second delay at any point in the prefix (displayed as a 
comma). 
#4 switches to pulse dialling (displayed as P). Tone dialling is the default.   
If a four-second delay is programmed at the first digit, the panel does not wait for a 
dial tone before starting to dial the number. Select this option when the phone 
system has a poor quality dial tone or does not generate a dial tone. 

 

PIR  Passive infrared motion sensor.  
Playback A menu entry that groups options that allow the installer to play back recorded 

voice messages.  
 

Power A menu entry that groups the power events that are reported to the selected 
phone number. (Phone Numbers) 
A menu entry that groups the power events that are reported to the central 
station. (System Reports) 
A menu entry that groups report codes that are sent to the central station when 
power related events occur. (Report Codes) 
A menu entry that groups the timer options relating to power events. (Timers)  

 

Power Failure A menu option that sends a message to the central station when power failure 
occurs. This is a CS7001 GSM module option.  

 

Power light An LED light indicating that the system is connected to the mains power. The 
power light is on when the mains power is on. The power light flashes when the 
system has a low battery condition.  

 

Power Modules See CS320 Power Modules  
Power Trouble and 
Restores 

A menu option that reports mains failure, mains restore, low battery and low 
battery restore events to the selected phone number. (Phone Numbers) 
A menu option that sends power trouble and restore reports to the central station 
depending on the condition of the panel dialler. (CS7001 GSM Module) 
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

Power Up Delay A menu option that sets the time between mains restore after a power failure and 
the system powering up again. This can be set from 0-60 seconds. 0 means no 
power up delay. 

 

Pre-dial Delay See Dialler Delay  
Prog Outputs A menu entry that groups options that configure outputs.   
Program Data Command A menu command request sent by the home automation system to the CS586 

Direct Connect module. It is used to configure the system through the serial port. 
 

Program Data Request A menu command request sent by the home automation system to the CS586 
Direct Connect module. It is used to read configuration data from the control panel 
through the serial port. 

 



 

Term Definition  
Program/Download A menu option that reports programming and up/download events to the selected 

phone number. (Phone Number) 
A menu option that reports programming and up/download events to the central 
station depending on the condition of the panel dialler. (CS7001 GSM Module)  
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

Programming A menu entry that groups home automation commands.   
Programming mode A mode of operation in which the installer can program the control panel after 

entering the Installer code to access the installer menu.  
 

Protocol  A menu option that sets the communicator format used to transmit to the receiver 
connected to a phone. Up to six phones can be set up. Multiple formats are 
available, such as Contact ID, SIA, 4+2 and pager format. Contact ID and SIA are 
the recommended formats. See appendix 4 for more information on communicator 
formats. (Phone Numbers) 
A menu option that sets the home automation protocol to binary or ASCII. (Home 
Automation) 

 

Proximity Readers See CS1700 Proximity Readers  
Pulsed Keyswitch A zone characteristic that allows a zone input to be used with a momentary 

keyswitch. Each activation of the keyswitch toggles the armed state of the control.
 

Q    
Quick Arm A menu option that enables the function keys for part arming and for full arming. 

These options work on a single-area keypad only.  
 

R    
Ready light 
 

An LED light indicating that the system is ready to be armed. The light is on when 
the system is ready to arm and off when it is not ready due to faulted zones. The 
light flashes when the system is ready to force arm.  

 

Ready State A menu option that lights LED 1 (Green) when the system is ready to be armed.  
Receiver Features A menu entry that groups programmable options for RF receivers.  
Receiver modules Modules that add wireless capability to the control panel. Adding a receiver 

module makes the control panel compatible with wireless transmitters or keyfobs. 
 

Recent Closing 
  

A menu option that sends a report to the central station if an alarm occurs within 
five minutes after the panel has been armed. The user number that armed the 
system is also sent. (Communications) 
A menu entry that specifies the code (SIA/ContactID/FastFormat/200Bd FSK) or 
voice channel to be used for recent closings events. (Report Codes) 

 

Recording A menu entry that groups recording options for messages sent by the CS535 
voice module.  

 

Re-exit A menu option that enables the exit delay without disarming the system.  
The exit delay can be restarted if in arm stay mode by using the Arm Away 
command in the user menu or by pressing a function key programmed by the 
installer to activate arm away.  

 

Reject beep An audio signal generated by the keypad buzzer that indicates code, command or 
value update rejection. 

 

Relay Active Time A menu option that sets the length of time the relay is activated when a proximity 
card is held against the CS1700 proximity reader.  

 

Relay State A menu option that lights the selected LED when the device’s relay is activated.  
Report Codes A menu option that groups codes that are sent to the central station when a 

particular event occurs. 
 

Report Mains Fault 
Always 

A menu option that sends a report to the central station if power is lost for the time 
programmed in Mains Delay Time. If this option is disabled, the report is sent only 
if the control panel has not sent a mains power lost report and Mains Fail report is 
enabled.   
This option applies only to the CS320 power module and not to the control panel. 

 



 

Term Definition  
Reporting A menu option that indicates that the CS7001 GSM module is currently reporting 

events to the panel via the GSM network. (CS7001 GSM Module) 
A menu entry that groups reporting options. (Communications) 
A menu entry that groups reporting options for the selected zone type. (Zone 
Types) 

 

Reports A menu entry that groups report options for the selected module.  
Reports Open/Close A menu option that specifies a code that reports arms (close) and disarms (open) 

to the central station. 
 

Require Code for 
Download  

A menu option that requires a user code to be entered before downloading can 
start. 

 

Reserved A location or segment that is not used.  
Reset Reader Address A menu option that wipes the proximity reader’s module number so that the reader 

can be learned in again on the control panel. 
 

Reset Smoke Detector A menu command that resets two-wire and four-wire smoke detectors and the Fire 
LED. For hardwired smoke detectors, the power supply to the smoke detectors is 
cut temporarily.  
RF smoke detectors have an auto reset because the RF communication is uni-
directional (from RF detector to RF receiver). This command does not reset RF 
smoke detectors but should still be used to reset the Fire LED.  

 

Response rate A reaction speed of inputs on the control panel and the CS208/CS216 input 
expanders. This can be either 50 ms or 500 ms.  
See also Loop Response  

 

Restore A report that is sent to the central station when a trouble/tamper condition is no 
longer active. 

 

Restore Reporting A menu option that causes restore events to be reported to the central station.  
RF Jammed The signal sent from an RF receiver to the control panel when the RF receiver has 

been jammed by an external RF source. This occurs when an RF source is above 
the RF jamming level for more than 30 seconds in a 60-second window. A restore 
report is sent to the central station when the signal from the RF receiver is no 
longer jammed. 

 

RF Low Battery  A menu option that sends a report to the central station when a low battery 
condition occurs in an RF sensor. (System Reports) 
A menu entry that specifies the code (SIA/ContactID/FastFormat/200Bd FSK) or 
voice channel to be used for RF Low Battery events. (Report Codes) 

 

RF Low Battery and 
Restores 

A menu option that sends a report to the selected phone number when a low 
battery condition occurs in an RF sensor. A restore report is also sent when the 
low battery condition is no longer active. (Phone Number) 
A menu option that sends a low battery report to the central station depending on 
the condition of the panel dialler. (CS7001 GSM Module)  
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

RF Receivers A menu entry that groups options relating to RF receivers.  
RF sensor A sensor that transmits to the control panel via an RF receiver rather than being 

directly wired to the control panel.  
 

RF Sensor Lost A menu option that sends a report to the central station when an RF sensor is 
missing. (System Reports) 
RF sensors send out supervision signals every 15 or 64 minutes, depending on 
the frequency. An RF receiver must receive these signals within a specified time 
window. This window is set by the Supervision timer. If the RF receiver does not 
receive these signals during the time window, the RF sensor is considered 
missing. 
A menu entry that groups report codes sent to the central station when an RF 
sensor lost event occurs. (Report Codes)  

 



 

Term Definition  
RF Sensor Lost and 
Restores 

A menu option that sends a report to the selected phone number when an RF 
sensor is missing.  A restore report is sent to the central station when the receiver 
receives a valid signal from the lost transmitter. (Phone Number) 
A menu option that enables RF sensor lost and restores reporting on a CS7001 
GSM module depending on the condition of the panel dialler. (CS7001 GSM 
Module)  
See also RF Sensor Lost, Panel Dialler OK Events and Panel Dialler Not OK 
Events 

 

RF Signal A menu entry that groups entries related to measuring RF signal strengths.  
See also RSSI Value 

 

RF zone A zone on the control panel with a learn-in wireless device, such as a keyfob, PIR, 
smoke detector or panic button. The control panel uses this zone number to reflect 
the state of the wireless device. 

 

RF433 receiver A type of RF receiver used with 433 Mhz.   
RF868 receiver A type of RF receiver used with 868 Mhz.  
Rings to Answer  A menu option that sets the number of rings that must occur before the panel 

answers to start a download session. If the value is 0, the panel will never pick up 
the phone line. (Communications) 
A menu option that sets the number of rings that must occur before the panel 
answers to start a listen-in session. If the value is 0, the panel or the CS534 will 
never react to an incoming phone line and will never pick up the phone line. 
Regulations in some countries do not allow a call in from an installer or central 
station without approval by the end-user. In this case the Answer U/D Call or 
Begin U/D Call menu options should be used instead.  (CS534 Listen-in Module) 

 

Roller Shutter A zone type used with roller shutter blinds. These zones can be used only on the 
control panel. They cannot be used on a CS208/CS216 input expander. 

 

RS232 cable A serial cable that connects the computer to the control panel.   
RSSI Check Zone A menu option that sets the zone number on the selected RF receiver. The RF 

receiver stores the signal strength of the transmission it receives from the sensor 
in this zone. To read the signal strength, open and close the zone and then select 
the RSSI Value menu option.  
• Values between 1 and 5: The detector will not work properly and must be 

moved to another location. 
• Values between 6 and 10: The detector will work but ideally should be moved 

to another location.  
• Values between 11 and 20: These are low values but the detector will still 

work properly. 
• Values between 20 and 50: These are normal working values for detectors 

located at a longer distance from the Receiver. 
• Values above 50: Perfect conditions. 

 

RSSI Value Remote Signal Strength Indication Value. This is a measure of the RF reception 
and is similar to the indication on a mobile phone. 
A menu entry that displays the RSSI value. The RSSI value is linked to the signal 
level of the GSM network. (CS7001 GSM Module) 
A menu entry that displays the RSSI value. The value is linked to the level of the 
signal between the wireless transmitters and the RF Receiver.  (RF Receivers) 
See also RSSI Check Zone 

 

S    
Schedule Times A menu entry that groups entries related to automatic arming, opening and 

closing schedules. 
 

Schedules A menu option that selects the schedules that affect the selected output. 
A menu entry that groups scheduling options. These options set the times to start 
and end an operation.  
See also Date of holidays, Only if Closed and Only if Open 

 

Segment A unit of a programming function. Each segment has between one and eight bits 
of data. A segment can also contain numerical values.  

 



 

Term Definition  
Send Code Entry 
Function 

A menu option that enables the send code entry function for the selected 
proximity reader action. The actions are Single Badge, Double Badge and Badge 
Hold. This function sends the same command to the control panel, using the 
proximity card, as a keypad would send if a valid code were entered. For 
example, if the system is armed, the selected action disarms it. 

 

Send Keypad Text A menu command request sent by the home automation system to the control 
panel. It is used in terminal mode to allow the device connected to the serial port 
to put text on the keypad. 

 

Send Restores A menu entry that groups restore report options. Each option specifies a time at 
which the restore report is sent to the central station. Restores can be sent As 
They Occur, At Disarm or For Zones On Siren Timeout.  

 

Sensor A device that detects violations and reports them to the control panel. Sensors 
include door and window contacts or any device used to inform the control panel 
of a particular condition.  

 

Sequential Programming A menu option that allows a group of RF sensors to be enrolled in sequence. 
Once the first sensor (Start Learning sensor) is configured, the detectors are 
learned-in in sequence. The value of ‘Start Learning’ is increased automatically. 
This option allows easier programming.  

 

Serial Number A menu option that contains the GSM Engine Serial number. It is used for 
diagnostics only. 

 

Serial Port A menu entry that groups the settings of the on-board Serial RS232 port.   
Service Check A menu command that is used to verify service messages.  

The service message disappears when the installer enters and then leaves 
programming mode. If Master Code Resets Tamper Memory is enabled, a master 
user can reset the service message by entering a master user code. 
See appendix 5 in the CS5500 Programming Manual for more information on 
service messages.  

 

Service Message A menu option that enables or disables the service messages on the keypad.  
A message displayed on the LCD keypad informing the user or installer of a 
system fault. The service message disappears from the keypad when the installer 
enters and leaves programming mode. The message is used as an Engineer 
Reset. 

 

Session Timeout A menu option that defines how long the CS534 listen-in module remains on the 
phone line with no activity from the central station.  

 

Set Date/Time A menu command request sent by the home automation system to the CS586 
direct connect module to set the time and date. 

 

Set Languages A menu option that selects the keypad language. There are four possible 
languages.  

 

Set User Authority A menu entry that groups home automation commands. The home automation 
protocol allows new users to be defined in the control panel. These commands 
specify the user’s authority, for example, partitions and arm/disarm.  

 

Set User Code A menu entry that groups home automation commands. The home automation 
protocol allows new users to be defined in the control panel. These commands 
specify the user’s code. 

 

Short Blast On 
 

A menu entry that groups internal sounder options. Each option specifies a time at 
which the sounder blasts. These options are: Arming, Exit Expiry, Closing Kissoff 
and Keyswitch Arming. 

 

Short Window A menu option that specifies the short supervision window for RF devices. RF 
devices on 433 Mhz typically report every 64 minutes. RF devices on 868 Mhz 
typically report every 15 minutes. Depending on the country regulations, this timer 
must be set to specific values.  
See also Supervision 

 

Shutdown Message A menu option that edits the message that is displayed on the keypad when the 
control panel is in shutdown mode. (Text)  
See also System Shutdown  

 



 

Term Definition  
SIA The Security Industry Association format. It is an FSK 300 baud format. 

SIA with Area Modifier is a version of the SIA format that sends partition 
information in addition to the event information.  
A special version of SIA, called XSIA, is used in Holland. XSIA combines user 
names and zone descriptors with the SIA codes when reporting events. The 
CSx75 range supports zone descriptors only. The zone descriptors are obtained 
from the first language of the keypad with module number 192 or, in other words, 
from the first keypad in the first partition.  

 

SIA Code  A menu option that sets the SIA code reported for the selected zone type. (Report 
Codes) 
A menu option that sets the SIA code reported for the autotest event. (CS7001 
GSM Module>Autotest)  
A menu option that sets the SIA code reported for the bus communication error 
event. (CS7001 GSM Module>GSM Options) 

 

Silent Auto Arm A menu option that arms the system automatically at a preset time without the 
keypad buzzer sounding. 

 

Silent Exit  A menu option that prevents the exit time buzzer activating when the system is 
armed or during the re-exit time. This option is activated by the user at the time of 
arming and is only active during this exit delay. 

 

Silent Exit Always A menu option that prevents the exit time buzzer activating whenever the system 
is armed or during the re-exit time.   

 

Silent Keypad A menu option that silences the keypad’s entry/exit sounder and chime only.  
Silent PA (7+9) A menu option that prevents all audible and visual indications when a personal 

attack alarm occurs. 
 

Silent panic See Silent PA (7+9)  
SIM Card Blocked A GSM menu option that indicates that the SIM card has been blocked and cannot 

access the system.  
 

SIM Card Trouble A GSM menu option that indicates that there is a problem with the SIM card.   
SIM PIN Accepted A GSM menu option that indicates that the PIN number for the SIM card has been 

entered correctly.  
 

SIM PIN Code A GSM menu option that displays the PIN code used to verify the user.   
Single Badge A menu entry that groups the functions activated by holding a proximity card once 

against the proximity reader. (Badge Functions)  
A menu option that sets the X-10 function sent when a proximity card is held 
against the proximity reader once. (X-10 Functions) 

 

Single Event Message A menu command that records a single event message. This message is sent by 
the CS535 voice module and states the event that has occurred. (Recording) 
A menu command that plays back a single message. (Playback)  

 

Siren blast 
  

A control panel sounder that is activated when the panel is armed, at the end of 
the exit delay or when the central station receiver acknowledges the closing 
report. It can also be activated for wireless arming and disarming.  

 

Siren Supervision  A menu option that monitors the siren to detect cut wires. If the wires are cut, the 
control panel sends a report to the central station. 

 

Siren Tamper  A menu entry that groups report codes sent to the central station when a siren 
tamper has occurred.  

 

Siren Tamper/Trouble A menu option that sends a report to the central station when a CS320 power 
module siren tamper or trouble condition occurs. 

 

Siren/Phone Faults and 
Restores 

A menu option that sends a report to the selected phone number when a siren or 
phone fault occurs. A restore report is sent when the fault is fixed. (Phone 
Number) 
A menu option that sends siren/phone faults and restore reports to the central 
station depending on the condition of the panel dialler. (CS7001 GSM Module) 
See also Panel Dialler OK Events and Panel Dialler Not OK Events  

 

Sirens A menu entry that groups together the siren events that can be selected to trigger 
an output. (Event) 

 



 

Term Definition  
SMS Format A menu option that specifies the SMS format used for reporting with the GSM 

module. The SMS format can be: Separate Events, Combined events, or SIA with 
Area Modifiers.  
See the GSM Module Installation Manual (CS7001) for more information. 

 

SMS Service Center 
Address 

A menu option that specifies the address of the service centre to which the 
CS7001 GSM module sends SMS messages.  

 

Software Revision A menu option that displays the current software version of the selected 
component.  

 

Sound A menu entry that groups sounder characteristics for a particular zone type. 
These characteristics determine the sounds produced by the sirens and keypads 
when the selected zone is activated.  

 

Sound On A menu entry that groups the events that activate the keypad sounder.   
Sounder Alert A menu option that activates the keypad buzzer when a user arms the system with 

one or more zones bypassed. 
 

Sounders A menu entry that groups timers for the internal siren, external siren and chime 
duration on the keypad.  

 

Sounds A menu entry that groups sounder characteristics for the current keypad. It 
defines the events that activate the keypad buzzer. 

 

Sounds On A menu entry that groups events that activate the internal siren.   
Speaker Lockout A menu option that prevents the central station turning on the speaker at the 

premises if a duress, silent panic or hold-up alarm is reported by the control panel. 
 

Speed A menu option that sets the data communications speed from the computer to the 
control panel. This can be set from 600 baud to 76.8k baud. It is recommended to 
use the default setting of 9600 baud. (System Settings) 
A menu option that sets the data communications speed from the CS586 direct 
connect module to the control panel. This can be set from 600 baud to 76.8k baud. 
It is recommended to use the default setting of 9600 baud. (CS586 Direct Connect 
Module) 

 

Split/multiple reports 
  
  

The CSx75 can be configured to report events to one or more phone numbers.  
Each phone number has an event selector to program which events are reported 
to each number.  
See Setting up a communicator in the CS5500 Programming Manual for more 
information.  

 

Start Learning A menu command that triggers the learn-in mode.  
See the Installation Manual for more information.  

 

Start Programming A menu entry that groups the reporting codes sent to the central station when 
programming starts. 

 

Start Zone A menu option that specifies the first zone number of zones on the RF receiver.  
Start/End Programming A menu option that causes reports to be sent to a specified phone number. A 

report is sent when local programming begins and ends.  
 

Status Check A menu option that allows the end-user to verify the system status using a touch 
phone. This option enables level 7. (CS534 Listen-in Module) 
A menu entry that groups the status indicators for GSM events. (CS7001 GSM 
Module)  

 

Store Comms Event A menu command that allows a device connected to the serial port to send reports 
to the central station using the controls modem. 

 

Summer/Winter Time  A menu option that allows automatic switching of summer and winter time.  
Supervised A menu option that enables supervision of the selected RF sensor.  



 

Term Definition  
Supervision  A menu entry that groups wireless supervision options. There are three options: 

Short Window, Normal Window and Fire Window. 
PIR and door/window sensors follow short and normal windows. If a PIR or 
door/windows sensor does not report within the time specified in Short Window, 
the system does not allow the user to arm the system. However, an RF Sensor 
Lost condition is not reported to the central station. 
If a PIR or door/windows sensor does not report within the time specified in 
Normal Window, an RF Sensor Lost condition is reported to the central station and 
a service message is displayed on the keypad. 
The short and normal window timers are configured differently according to 
country and frequency. 868 Mhz transmitters typically report every 15 minutes 
while 433 Mhz transmitters typically report every 64 minutes. 
When the Arming with Zone Lost option is enabled, the user is always allowed to 
arm the system even if the PIR or door/window sensor does not report within the 
short window.   
  
Smoke detectors follow the fire window. 433 Mhz and  868 Mhz smoke sensors 
report every 64 minutes. Smoke detectors follow supervision windows only and 
report to the central station when not reporting within the fire window. 
See also Arming with Zone Lost 

 

Swinger Shutdown A zone characteristic that allows the selected zone to be automatically bypassed 
after a specified number of alarms. (Input Type)  
A menu entry that contains the swinger count. (Inputs) 

 

System Reports A menu entry that groups options relating to system reports.   
System Settings A menu entry that groups programmable system features and reporting options.   
System Shutdown A menu option that allows the up/download software to shutdown the control 

panel. This option can be set only from the up/download software. The shutdown 
LCD message is shown to explain the reason for the shutdown. During shutdown 
the system is completely inactive. It is not possible to arm/disarm the system and 
no reports or sirens are activated.  

 

System Status A menu request sent by the home automation system to the CS586 direct connect 
module to view the system status of the entire system. (Commands/Requests) 
A menu command request sent by the home automation system to the CS586 
direct connect module to transmit the system status. (Transition Broadcasts) 

 

T    
Tamper loop A loop set to detect interference with the hardware. It is generally a monitor circuit 

used to detect any attempt to modify the alarm circuitry, such as cutting a wire. It 
generates a tamper alarm when activated. 

 

Tamper switch  A switch that detects attempts to remove the enclosure of some alarm 
components, such as control box doors, switch covers, junction box covers, or bell 
housings.  

 

Tamper/Trouble A menu entry that groups together the tamper and trouble events that can be 
selected to trigger an output. (Event) 
A menu entry that groups together the tamper and trouble events that are reported 
to the central station. (System Reports) 

 

Tampers A menu option that activates the internal siren when a tamper occurs. (Internal 
Siren>Sounds On) 
A menu option that sends a report to the central station when a tamper occurs. An 
alarm is activated and the state of the area may change to alarm. 

 

Tampers and Restores A menu option that sends a report to the selected phone number when a tamper 
occurs. A report is also sent when the tamper is no longer active. (Phone 
Numbers) 
A menu option that sends tamper and restore reports to the central station, 
depending on the condition of the panel dialler. (CS7001 GSM Module) 
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 



 

Term Definition  
Telephone line monitor 
  

A menu option that monitors the voltage and current of the telephone line to detect 
a faulted phone line. If a fault is found, the panel sends a report to the central 
station when the phone line fault is fixed and the phone line can be used again. 

 

TELIM Channel A menu option that specifies that the TELIM channel format is used to report the 
selected zone, zone type or event.  

 

Temporal Siren - Fire A menu option that sets whether a zone type activates a fire or a burglary siren.    
Test Reports A menu option that sends a test report to the selected phone number at pre-

programmed intervals. The units can be set in days or hours. (Phone Numbers) 
A menu option that sends a test report to the central station at pre-programmed 
intervals depending on the condition of the panel dialler. (CS7001 GSM Module) 
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

Tests A menu entry that groups settings related to different tests. These include tests 
such as automatic test calls, dynamic battery tests and so on.  

 

Text A menu entry that groups the language options of the current keypad. It allows 
the installer to set options such as zone name descriptors and user names. 

 

This Keypad A menu entry that groups the settings of the current keypad. It allows resetting of 
the keypad, configuration of keypad features and verification of software version 
and models.  

 

Time A menu option that sets the length of time for which an output is activated. If it is 
set to 0, the output follows the event.  

 

Time Since Test A menu option that sets the length of time since the last test. It forces the next test 
report to be sent to the central station at less than the full interval. 
See also Interval 

 

Time Unit A menu option that specifies whether the outputs are timed in minutes or seconds.  
Timers A menu entry that groups timer options.   
To All Keypads A menu option that specifies that the current keypad settings are copied to all 

connected keypads.  
 

To One Keypad A menu option that specifies that the current keypad settings are copied to one 
specific keypad.  

 

Tone sniff answering 
machine defeat 

See Answer Machine Defeat   

Tones Audible indicators sounded by the system that can be heard at the central station 
during a two-way session.  

 

Transformer Size A menu option that specifies the size of the transformer that is used. There are 
two possibilities: 25 VA or 40/50 VA. Depending on the setting, the power supply 
of the CS275, CS575 and CS875 can deliver 0.5 A (25 VA setting) or 1 A 
(40/50VA setting) on the AUX terminals. If this is not sufficient, additional CS320 
power modules can be used.  

 

Transition Broadcasts A menu entry that groups methods of sending updated information to the home 
automation system from the RS232 interface.  

 

Trouble A zone type that sends an alarm when the system is armed and trouble when the 
system is disarmed. 

 

Trouble conditions  Faults detected by the system. Trouble conditions include; tamper, hardware, low 
battery and loss of supervision. 

 

Two-way mode See Two-way session  
Two-way session A session between the central station and the premises. During this session, the 

central station can send and receive audio information to and from the premises. 
The session is controlled from the central station using key presses on a touch-
tone telephone. 

 

Type A menu option that specifies the type of GSM engine used.  
U    
Up/Download A menu entry that groups options used to control download sessions between the 

up/download software and the control panel.  
 



 

Term Definition  
Up/download software Management software that can read the system programming information (upload) 

or modify or replace the information if necessary (download).  
 

Upload The process of retrieving information from a computer running the up/download 
software. 

 

User A person who is authorised to operate the alarm system. A user can operate the 
system through a user device such as a keypad or keyswitch. 

 

User Card Programming  A menu option that defines the access card readers that can enrol or program 
cards.  

 

User Code A four or six-digit code used to arm/disarm and access the system.  
User Info Request  A menu command that allows the device connected to the serial port to read out 

the programmed settings for a particular user. This can be activated with a PIN or 
without a PIN. This is a home automation command. 
See also With PIN and Without PIN  

 

User menu The menu displayed when a user code is entered.  
User Names A menu option that specifies a name for each user code. The maximum length of 

a user name is 15 characters.   
 

User Phone Editing A menu option that allows the user to change the phone numbers used for alarm 
reporting.  
Typically, the installer programs the central station phone numbers and is the only 
person who can change the number.  
However, when voice protocol and siren protocol are used, the user can change 
the phone number. These protocols typically report to the homeowner’s mobile 
phone rather than to the central station.  

 

Users 
 

A menu option that specifies the zone or user number that triggers the output on 
the expander module or power module. (CS507 Output Expander) (CS320 Power 
Module) 

 

V    
Version A menu option that displays the current software version of the selected 

component. This is available for all expansion modules, keypads and the control 
panel.  

 

Voice Channel A menu option that sets the voice message to be reported for the selected zone 
type or event. The channel corresponds to one of the 15 pre-recorded voice 
messages.  
See the CS5500 Installer Manual for more information on the voice module.  
See also All in Sequence 

 

Voice Module See CS535 Voice Module  
Voice/Siren Dial 
Attempts 

A menu option that specifies the number of dial attempts (1 to 15) that the 
communicator makes for voice dialing, pager or Siren Tone formats. 

 

Volumes A menu entry that groups options to adjust levels used with the CS534 listen-in 
module. 

 

W    
Walktest A menu option that enables walktest mode. This mode allows an authorised user 

to test the detection devices and to verify that all zone inputs operate correctly.  
 

When Armed A menu option that specifies if the selected feature is active when the system is in 
an armed condition.  

 

When Disarmed A menu option that specifies if the selected feature is active when the system is in 
a disarmed condition.  

 

Window The period of time within which an operation, function or event must occur. If the 
event misses the window, the event is invalid. 

 

Wireless zone See RF zone  
With PIN A menu command request sent by the home automation system to the CS586 

direct connect module to grant user access with a PIN number only.  
 

Without PIN Command request sent by the home automation system to the CS586 direct 
connect module to grant user access without a PIN number. 

 



 

Term Definition  
Word Library A menu option that enables the word library. This is a predefined collection of 

words that speed up text editing. As the user/installer types a character, the 
keypad automatically displays a matching word. The word library is enabled by 
default. 

 

Wrong PIN Digit Entries A menu option that specifies the maximum number of incorrect digits that can be 
entered for call-back and call-in features before the panel is locked out. 

 

X    
X-10 Address A menu option that sets the address of an X-10 device. This is a unique number 

assigned to an X-10 device. It consists of the module number and house code. 
The system uses this address to identify the device.   

 

X-10 Devices A menu entry that groups X-10 device options for the selected keypad. (This 
Keypad) 
A menu entry that groups X-10 device options for the selected listen-in module. 
(CX534 Listen-In Module) 

 

X-10 Function Logged 
Code Entry 

A menu option that activates an X-10 function when a proximity card is held near 
the CS1700 proximity reader. 

 

X-10 Functions A menu entry that groups X-10 device information and the functions for the 
selected CS1700 proximity reader.  
The X-10 functions are linked to the access reader. It is possible to control X-10 
devices using the badge on the card reader. It is also possible to configure the 
actions that are activated by each card action.  
• 0 All units off  
• 1 All lights on  
• 2 On 
• 3 Off All others  
• 4 Dim 
• 5 Bright 
• 6 All lights off 

 

X-10 Message  A menu option that enables X-10 message transition broadcasts. (Transition 
Broadcasts) 
A menu option that enables the control panel to respond to X-10 message 
commands sent by the home automation system. (Commands/Requests) 

 

Y    
Yelping Siren - Burglary A menu option that sounds a yelping siren when a burglary zone is activated.  
Z    
Zone Bypass A menu option that that sends a report to the central station when zones are 

bypassed. 
 

Zone Bypass and 
Restores 

A menu option that sends a report to the selected phone number when a zone is 
bypassed. A report is also sent when the zone is restored (un-bypassed). (Phone 
Numbers) 
A menu option that sends a report to the central station when a zone is bypassed. 
A report is also sent when the zone is restored. These reports are sent depending 
on the condition of the panel dialler. (CS7001 GSM Module)  
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

Zone Bypass Toggle A menu option that enables the control panel to respond to zone bypass toggle 
commands sent by the home automation system. (Commands/Requests) 

 

Zone Inact. Unit A menu option that allows the zone inactivity option to be configured in hours or 
days.  

 



 

Term Definition  
Zone Inactivity Monitor A zone characteristic that sends a report to the central station when the zone does 

not change conditions within a specified time period. (Zone Types) 
A menu option that sends a report to the selected phone number when a zone 
inactivity event occurs. (Phone Numbers)  
A menu option that sets the zone inactivity time. It is possible to specify this time in 
minutes or hours. (Timers)  
A menu option that sends a report to the central station when a zone inactivity 
event occurs, depending on the condition of the panel dialler. (CS7001 GSM 
Module)  
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

Zone Lost Gives Tamper A menu option that sends a report to the central station when a wireless zone 
sensor is lost and activates a tamper alarm. Different reports are sent depending 
on the system status. When armed the tamper and the lost report are sent. When 
disarmed only the lost report is sent.  

 

Zone Name A menu option that allows the installer to define names for each installed zone. 
For example, Zone 1 can be named Living Room PIR. (Zones) 
A menu option that enables the home automation system to change zone names 
on the control panel. (Commands/Requests) 

 

Zone Names See Zone Name  
Zone Restore A menu option that sends a report to the central station when zones are restored.  
Zone Snapshot A menu option that allows the control panel to send a snapshot of the current 

status of the zones. A snapshot sends the tripped, bypassed, trouble/tamper and 
alarm memory state for sixteen zones. This is done on a zone-by-zone basis. 
(Transition Broadcasts) 
A menu option that enables the control panel to respond to zone snapshot 
requests sent by the home automation system. (Commands/Requests)  

 

Zone Status A menu option that sends the entire status for one zone. (Transition Broadcasts) 
A menu option that enables the control panel to respond to zone status requests 
sent by the home automation system. (Commands/Requests) 

 

Zone Tamper A menu option that sends a report to the central station when a zone tamper 
occurs. (Communications>Reporting) 
A menu entry that groups report codes that are sent to the central station when a 
zone tamper event occurs. (Report Codes) 

 

Zone Trouble A menu option that sends a report to the central station when a zone trouble 
condition occurs. (Communications>Reporting) 
A menu entry that groups report codes that are sent to the central station when a 
zone trouble condition occurs. (Report Codes)  

 

Zone Trouble and 
Restores 

A menu option that sends a report to the selected phone number when a zone 
trouble condition occurs. A report is also sent when the trouble condition is no 
longer active. (Phone Numbers) 
A menu option that sends zone trouble and restore reports to the central station, 
depending on the condition of the panel dialler. (CS7001 GSM Module) 
See also Panel Dialler OK Events and Panel Dialler Not OK Events 

 

Zone Type A menu option that specifies the zone type of a particular zone. There are 20 
different zone types. The default zone types can be customised. 

 

Zone Type Name See Zone Type Name  
Zone Type Names A menu option that allows the installer to define names for each installed zone 

type. For example, Type 1 can be named Burglary A Alarm, Type 2 can be named 
Fire Alarm, Type 3 can be named Entry/Exit and so on.  

 

Zone Types A menu entry that groups zone type characteristics and allows the installer to 
select a pre-defined zone type. There are 20 pre-defined zone types. The 
characteristics of each zone can be changed. For example, if a keypad beeps, if 
the zone is a delay 1 or delay 2 zone, a 24-hour zone and so on. (Inputs) 
A menu entry that groups all reporting codes for the selected zone type. (Report 
Codes) 

 



 

Term Definition  
Zone/User A menu option that sets the zone/user number that is used to send an SIA 

message when a Bus communication error occurs. The parameters, SIA Code, 
Partition and Zone/User provide flexibility to define the SIA Code and partition and 
zone/user. For example Ri1/ET01. (Bus Comm Error) 
A menu option that specifies that the selected event must occur on a specific zone 
or by a specific user. (CS507 Output Expanders) 

 

Zones 
  

A menu entry that groups zone options.  
A zone is an area guarded by a group of one or more detection devices. It 
represents a single input in the system.  
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